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Copyright notice

No part of this Instructions for Use or program may be reproduced, stored in a retrieval system,
or transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or
otherwise, without the prior written consent of Auditdata A/S.

Copyright © 2025, Auditdata A/S

Written in Denmark by Auditdata A/S, Denmark.

All information, illustrations, and specifications in this manual are based on the latest product
information available at the time of publication.

Auditdata A/S reserves the right to make changes at any time without notice.

Model Product name
Primus Fitting Unit - PFU+ Primus PFU+ (PFU+)
2000 Primus Fitting Unit Pro Primus Pro (PFU Pro)
2000 Primus Audiometer Unit Ice Primus Ice

2000-1 Fitting Unit Measure

2000 Primus HIT Pro Primus HIT Pro

Auditdata

© Auditdata - 2025, ID: 20.0109/24 2



Instructions for use

L INtrodUCtiON ... . 5
2 Abbreviations and TE€rMS ... 5
B OYMbOIS USeA ... 7
4 Compliance With Standards ... 8
5 Intended Use/Indications for USe ... 10
B Safety INStrUCHIONS ... 11
B. L AP I EA PN oo 11
B. 2 FItting UNit . 11
6. 3Fitting and HIT UNits ... 12
O. A HIT UNIt 14
6.5 Contraindications ...l 14
T Precaulions ... 15
7. L Principles of Operation ... 15
7. 2 MEASUIEMENT ACCUIACY ..o, 15
7. 3 EMC (Electromagnetic Compatibility) Precautions ... 16
8 Installation and Set-Up ... 17
8. L HAIAWAIE SOIUD ..o 17
8.2 Software Installation ...l 30
8.3 Installing Your LiCeNSe ... . 31
8. 4 Test DefiNitioNs Set-Up ..o 32
8.5 Configuring Types oOf VisitS ... 34
8. 6 Activating Workflow SUPPOIt ... 35
8. 7 Activating TranSAUCEIS ... ... 38
8. 8 Connecting Transducers to a Sound Booth ... 38
8. 9 Calibration of Free-Field Loudspeakers - Sound Field Calibration ............................... 39
8. 10 Addition of External Sound Files for Speech Audiometry and Speech Mapping ....... 42
8. 11 Calibrating Speech CD Material ... 43

© Auditdata - 2025, ID: 20.0109/24 3



Instructions for use

8. 12 Selecting Client and Entering Client Data ... 44
8. 13 Obtaining Hearing Threshold LEVEIS ... ... 44
8. 14 Shutdown ProCedure ... 48
O MaINtENANCE ... ... 48
9. 1 Annual Calibration of Headset and Transducers ... 48
9. 2 Adjustment of Common Headsets and Microphones ... 48
9. B Regular System CheCKS ... 49
O, A NS PO I ON 51
. D CANING 51
9. 6 Switching 1o @ NeW TranSAUCET .. .. ... 51
9. 7 Securing Patient Data ... 52
10 Troubleshooting Guide ... 53
11 Hotline and Technical SUPPOIt ... 56
AP ENAIX A A-1
A.1 Declarations of CoONTOrMItY ... A-1
A2 ManufaCturer ... A-6
ABLabelling ... A-7
APPENAIX B B-1
B.1 Technical SpecCification ... B-1
B.2Technical Data ... B-8
B.3 EMC Conformance RequUirements ... B-12
B.4 Pin Assignments Table ... B-15
APPENAIX € C-1
C.1 Minimum Requirements (for Software Installation) ... C1

© Auditdata - 2025, ID: 20.0109/24 4



Instructions for use

1 Introduction

This document aims to provide instructions on setting up Fitting and HIT Units as well as
installing and configuring the software. It also includes essential information on safety meas-
ures, maintenance, and calibration.

The Fitting Unit is a general term combining PFU, PFU+, Primus Pro, Primus Ice, and 2000-1
FU hardware units. Please refer to the Abbreviations and Terms section for definitions of these
units.

Up to version 4.2, the software was released under the name of Primus. The release following
Primus 4.2 acquires the name Measure and the version number 6.0.

Depending on your purchased licenses, some of the modules described in this document might
not be available in your version of software. Please contact your distributor to get more inform-
ation on the licenses.

This document is not intended to be a complete reference. For detailed information, please
refer to the Help file after installing the software.

2 Abbreviations and Terms

Term Definition

PFU stands for Primus Fitting Unit. This includes PFU, PFU+, and Primus

PFU Pro hardware units. These units are used to perform pure tone and speech meas-
urements as well as REM and SM measurements.

Fitting - . . - . .

Unit Fitting Unit is the collective name for all fitting unit devices.

Primus Primus Ice is the name for Primus Audiometer Unit. This unit is used to perform

Ice pure tone and speech measurements only.

HIT HIT stands for Hearing Instrument Test chamber.

AUD Audiometry.

REM Real Ear Measurements.

SM Speech Mapping.

Hearing Threshold Level. Establishes the minimum level at which the client can

HTL . o
detect the presence of a pure tone signal 50% of the time it is presented.

© Auditdata - 2025, ID: 20.0109/24 5



Instructions for use

Model name | Product Additional information

2000 Primus | Primus
Fitting Unit Pro (PFU
Pro Pro)

2000 Primus PFU (Primus Fitting Unit) is the collective name for these devices:
Audiometer | Primus Ice | Primus Pro, Primus Ice and Primus PFU+ (2000 family of
Unit Ice devices).

Primus Fit- Primus
ting Unit - PFU+
PFU+ (PFU+)
2000 Primus
HIT Pro Primus o .
(2005-1 HIT | HIT Pro Hearing instrument test unit.
Unit)
2000-1 FU stands for Type 2000-1 Fitting Unit. This Unit is in
functionality very similar to the PFU and is also used to perform
2000-1 Fit- pure tone and speech measurements as well as REM and SM
ting Unit Measure | measurements.

In Measure software, the device is displayed as 2000-1 Fitting
Unit (Measure Aud).
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3 Symbols Used

The following symbols are used in this document and/or on labelling on the device.

Labels on Fitting Unit and HIT Unit

N

H\Iizi E L

X
(1]
=

=S
O

Labels only on Fitting Unit

> E O O] >

‘)

€ 0123

Labels only on HIT Unit

>

Manufacturing date

Manufacturer's name and address

Disposal instructions

Serial Number
Reference Number

This device is a medical device

Type B applied parts.
Patient applied parts that are not conductive and can be
immediately released from the patient.

Class Il equipment

Follow operating instructions

Operating instructions

General warnings

CE - notified body

Caution, please read the Instructions for Use and the User
Manual
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Ce .

4 Compliance with Standards

Classification according Annex VIl of EU Medical Device Regulation MDR (EU) 2017/745:

Device Class Rule CE GMDN Basic UDI-DI

Primus Fitting Unit (all vari- | 10 | |45241 |05711781DHF20002C

ants) 0123

2000 Primus Audiometry | - 10 |°F  |37503 |05711781DHF20002C

Unit (Ice) 0123

2000 Primus HIT Pro | 13 |CE | 41217 |05711781DHF2000ZC

2000-1 Fitting Unit lla 10 |CF  |45241 |05711781DHF2000ZC
0123

Note: Medical device classification may vary across different markets depending on local legis-

[ation.

All Auditdata devices covered in this manual, including the listed accessories and respective
applied parts, comply with the Council Directive RoHS-1I/2011/65/EU.

The Fitting System complies with the following standards:
Safety:

e |[EC 60601-1:2005+A1:2012 CSV, class 2, type B
e |[EC61010-1:2010 for HIT Unit

EMC:
e |[EC60601-1-2:2014+A1:2020 CSV
Audiometry:

e Tone: |IEC 60645-1:2017 / ANSI S3.6:2018 Type 1
e Speech: IEC 60645-1:2017 / ANSI S3.6:2018 Type A or A-E

Real Ear Measurement:
e |[EC 61669:2015 and part of ANSI S3.46:2013
Hearing Instrument Testing:

e |[EC60118-7:2005
e |[EC60118-15:2012
e ANSI S3.22:2009

© Auditdata - 2025, ID: 20.0109/24



Instructions for use

Medical electrical equipment

e EN 60601-1-6:2010+A1:2013+A2:2020
Medical device software

e |[EC 62304:2006+A1:2015
Medical devices

e |[EC 62366-1:2015

e ENISO 14971:2019

e« ENISO 13485:2016
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5 Intended Use/Indications for Use

The Fitting Unit is intended for use by professionals such as an audiologist, hearing healthcare
specialist, or trained clinicians. The devices must only be used for their intended purpose as
stated in this document below.

Audiometric testing should take place in a sound treated quiet environment and care should be
taken to ensure optimal test conditions and safety of the client during testing.

2000-1 Fitting Unit , PFU and Primus Ice

The Fitting Unit is intended for performing hearing tests.

The Fitting Unit with stated accessories is indicated for non-continuous, noninvasive air
and optionally bone conduction and speech audiometric testing in quiet office and sound
treated environments.

The Fitting Unit is indicated for use with both paediatric and adult age groups.

The Fitting Unit is not indicated as a sole means of diagnostics.

2000-1 Fitting Unit and PFU Only

The Fitting Unit is indicated for non-continuous real-ear measurements at the ear drum by
means of noninvasive external ear canal insertion of a probe tube in quiet office envir-
onments.

Finally, the Fitting Unit can be used to present hearing instrument related sound

examples through headsets or loudspeakers.

2005-1 HIT Unit

The Hearing Instrument Test Unit is intended for use by professionals such as an audi-

ologist, hearing healthcare specialist, or trained technician.
The Hearing Instrument Test Unit is intendent to apply sound to the hearing aid in a

closed test box and obtain the acoustical output of the hearing aid in a coupler cavity
equipped with a microphone.

The Hearing Instrument Test Unit is intended to be used together with the Software to
provide objective indication of the characteristics of a Hearing Aid. Visualization of the
obtained coupler microphone signal is only available in the Software application.

The Hearing Instrument Test Unit is indicated for technical quality inspection or fitting of
hearing instruments with no clients involved.
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6 Safety Instructions

A\ PLEASE READ THE SAFETY INFORMATION COMPLETELY BEFORE USING THE FITTING
SYSTEM!

6. 1 Applied parts

¢ The headsets / patient switch are only to be used with uninjured skin of the test person.

The time of usage is short duration and less than 24 hours.
¢ Parts that come into contact with the client (that is, transducers, the handheld push-but-

ton, and the probe microphone set) should be disinfected before use.

6. 2 Fitting Unit

¢ Parts such as foam tips on insert earphones or probe tubes for real-ear measurement are
not intended for reuse. Dispose of such items in a hygienic manner after each client ses-

sion.
* Do not use talk forward microphone in areas where there is risk of acoustical feedback.
¢ The headphones supplied must not be used with any other branded equipment. Head-

phones from other branded equipment must not be used with the system.
¢ Connect only such headphones and other external devices that are approved for con-

nection to the System.
¢ Probe tube measurements must be performed by trained professionals only.
¢ Avoid exposing the client or other persons to unnecessarily high sound pressures, as

these may be damaging to hearing.
e Before applying the headphones or insert phone, inspect the patient’s ear drum, ear

canal, pinna and surrounding areas for lesions or other types of infection. Do not use the

headphones or insert phones if any contraindications exist.
¢ Remove any barriers before placing the headphones or insert phones on the patient,

such as jewellery or the patient’s hair during the test.
¢ During real-ear measurements, carefully position the probe tube so as not to contact the

ear drum.
¢ Accessory equipment connected to the analog and digital interfaces must be in com-

pliance with the respective nationally harmonized IEC standards ( IEC 60950 for data pro-
cessing equipment, IEC 60065 for video equipment, IEC 61010-1 for laboratory
equipment and IEC 60601-1 3rd for medical equipment). Furthermore all configurations

shall comply with MEDICAL ELECTRICAL SYSTEM in IEC 60601-1 3rd.
¢ Everybody who connects additional equipment to the signal inputs/outputs configures a

MEDICAL ELECTRICAL SYSTEM, and is therefore responsible that the system complies
with the requirements of the standard IEC 60601-1 3rd. If in doubt, consult the technical

service department or your local representative.
e To comply with MEDICAL ELECTRICAL SYSTEM in IEC 60601-1 3rd the Audiometer, equip-

ment parts and ACCESSORY, except for specified Type B applied parts, must be located
outside PATIENT ENVIRONMENT, i.e. not closer than approx. 1.5 meters/5 ft.
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The use of accessory equipment not complying with the equivalent safety requirements of
this equipment may lead to a reduced level of safety of the resulting system. Con-
sideration relating to the choice shall include:

¢ Use of the accessory in the PATIENT VICINITY.
* Evidence that the safety certification of the ACCESSORY has been performed.
¢ In accordance to the appropriate IEC 60601-1 3rd.

6. 3 Fitting and HIT Units

6. 3.

1 Maintenance and Cleaning

Do not modify the equipment without authorization of the manufacturer.
Maintain a high level of hygiene and clean reusable devices which come into contact with

clients between each use. See the cleaning instructions below.
For cleaning use only a soft dry cloth dampened very sparingly with a low level dis-

infectant solution such as isopropyl alcohol to wipe the device. Do not allow excess solu-

tion to enter the device as this may damage internal components.
Do not use acetone or paraffin/kerosene-based solutions, or any other harsh solvent to

clean the device or its accessories. Use of such substances may be harmful to the equip-

ment and may result in faulty operation.
The headphones, probe microphone set, cables, connectors and other electrical accessor-

ies are not waterproof. See the Cleaning instructions for safe handling.

. 2 Usage

The system with attached accessories is to be operated by qualified personnel only.
The device is intended only as an adjunct in client assessment. It must be used in con-

junction with assessment of clinical indicators and symptoms.
The main power supply should be easily accessible for plugging/unplugging.

"’ If the PC complies with IEC 60950 or with IEC 60601-1 3rd, use the USB cord to
connect to the system. Do not touch the USB connector from the PC and the patient at

the same time, when a IEC 60950 approved PC is used.
The device should be directly connected to the PC and not to a USB hub.
Do not use defective equipment. If you suspect a malfunction, contact a service rep-

resentative authorized by manufacturer for inspection of the equipment.
On a regular basis, that is, at least once a week, perform a visual inspection of the Fitting

and HIT Units and their accessories for visible damages. Do not use damaged head-
phones or accessories with the device. During use, evaluate the test results and perform

a system inspection if the results appear unreliable.
When using the device with insert phones or probe-tube set, note that the used foam ear

tips or probe tube should be disposed in a manner consistent with normal infection con-

trol procedures.
In the event of irreparable damage to the device, dispose of it through an approved haz-

ardous materials disposal facility in accordance with the RoHS (Restriction of the Use of
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Certain Hazardous Substances) and WEEE (Waste Electrical and Electronic Equipment)

regulations, or return it to manufacturer.
Do not connect non-medical equipment unless it forms part of the medical system. There

is a danger that the leakage currents may exceed their valid limits and consequently be a
hazard to the client and the examiner.

The devices should be contained in an environment according to the operational spe-
cifications, so that the temperature and humidity does not rise above dangerous meas-
ures. Refer to B.1 Technical Specification for allowed temperature, humidity, and air
pressure.

Do not expose the device to moisture. Extreme moisture can cause the device to fail or

perform inaccurately.

The devices must only be used for their intended purpose.

All tests must be conducted in a sound treated or sound proof room with low ambient
noise.

Excessive movements should be avoided during the test, as it may interfere with the

measurement and can result in wrong measurement results.
The headset and transducers delivered with the Fitting System and reference and coupler

microphones delivered with the HIT Unit are NOT intended for calibration by users.

Contact your local distributor for your annual service and calibration.
Do not pull the headphone cable. To disconnect the headphones or other accessories

from the device, pull the plug.
The examiner should take care never to touch non-medical parts of the system and the cli-

ent at the same time.
EXPLOSION HAZARD: Do not use the device in the presence of flammable substances.
ELECTRIC SHOCK HAZARD: Do not attempt to disassemble the device. The device con-

tains no user-serviceable items inside.
Carefully route all the cables to reduce the possibility of entanglement or strangulation.
Fasten the Fitting Unit on a wall, under a table or place it on a stable surface. If con-

sidered more practical, the Fitting System can also be placed inside the audiometric

booth or piggyback to the HIT unit. Place the HIT Unit on a stable surface.
Do not place the system on or near equipment that generates a strong magnetic or elec-

trical field, as this may cause improper operation and interfere with the intended use of

the device.
If mobile multi-outlet power strips for mains power supply are in use:

e they must comply with MEDICAL ELECTRICAL SYSTEM in IEC 60601-1 3rd
e their rated current must not be exceeded
Cables should be changed by properly qualified personnel only.
Any external equipment should be connected in such a way that the Fitting Unit with con-

nections still observes the safety requirements in IEC 60601-1 3rd.
Conductors and wiring between the system components must be protected against mech-

anical damage.
If the PC is in use and not compliant with IEC 60950 or IEC 60601-1 3rd, use optical USB

connection Type OPTICIS M2-100-03 with power supply type Friwo FW7662M/05, type
Friwo FW8002M/05 or optical USB connection Type IF-TOOLS; ISOUSB-BOX-PLUS; Art.
No.: 14000.
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¢ Use only with the power supply that is supplied with the system - type Friwo

FW7362M/15 or type Friwo FW8030M/15.
¢ Any serious incident that has occurred in relation to the device should be reported to the

manufacturer and the competent authority of the Member State in which the user and/or
patient is established.

6. 4 HIT Unit

¢ The Hearing Instrument Test Unit is a laboratory equipment and must not come into con-
tact with the patient. The hearing instrument used in the HIT Unit must NOT be connected
to HIT Unit and the patient at the same time.

6. 5 Contraindications

¢ Patients unable to cooperate because of young age or other conditions cannot undergo
pure tone or speech audiometry. They may need to have the auditory system tested by
other methods.

¢ The patient shall be asked about any exposure to loud noise during the previous 24
hours, as this can cause a temporary hearing loss. If the answer is yes then it may be
necessary to re-test the subject at a time when they have had no recent exposure to
noise.

¢ Audiometry shall be preceded by otoscopic examination. Occluding wax may be removed
prior to audiometry but if wax is removed the procedure shall only be undertaken by
someone who is qualified and competent to do so.
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7 Precautions

7.1 Principles of Operation

7.1.

7.1.

7.1.

1 Audiometry

Presentation of pure tone sine wave and speech stimuli for threshold determination and
supra-threshold testing within the range of 125 Hz to 16 kHz and varying intensity levels
to assess client hearing levels.

2 Real Ear Measurement

Please also note the REM standard IEC 61669 mentioned in Chapter 4. Besides technical
specifications, terms and definitions, it contains additional helpful recommendations
regarding the test set up, such as location of subject and tester, or location of field ref-
erence and measurement point.

Presentation of pure tone sine wave or complex stimuli within the range of 125 Hzto 16
kHz for measurement at the ear drum by means of a flexible probe tube inserted into the
ear canal. The measurement may take place with or without a hearing instrument inser-
ted.

3 Hearing Instrument Test System

Presentation of pure tone sine wave or complex stimuli through a loudspeaker or teleloop
system within the range of 125 Hz to 16 kHz. Measurement and quality inspection of
hearing instruments in a dedicated hearing instrument test chamber.

7.2 Measurement Accuracy

If the accuracy of the device measurements does not seem reasonable, check the device for
proper functionality. The measurement and signal presentation data, including stability, exact-
ness and tolerances appear from the section Technical Specification.

Inaccurate measurements may be caused by factors such as:

Excessive ambient noise in the test environment
Excessive movements by client or operator

Occlusion of the outer ear by hair or jewellery, or occlusion of the ear canal by objects or
cerumen

Incorrect placement of headphones, probe microphone set or free-field loudspeakers

Incorrect headphones, loudspeakers or probe microphone set, or components such as
cables, ear cushions, etc.

Malfunction of the headphones or the device

© Auditdata - 2025, ID: 20.0109/24
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@ WARNING! Use of the device in any way other than as described in this document may res-
ult in inaccurate results or injury.

7.3 EMC (Electromagnetic Compatibility) Precautions

The system is suitable for use in all establishments other than domestic, but it can be used in
domestic establishments and those directly connected to the public low-voltage power supply
network that supplies buildings used for domestic purposes, if the following warning is taken in
account:

@ WARNING! This system is intended for use in professional healthcare environment only and
might interfere or be disturbed by nearby equipment, therefore, it may be necessary to take mit-
igation measures, such as reorienting, relocating or shielding the location.

Install and operate the System according to the EMC information, warnings and recom-
mendations to prevent adverse events to the patient and operator due to electromagnetic dis-
turbances for the expected service life time.

@ WARNING! Failure to comply with the precautions listed in this section may cause present-
ing of unwanted hearable noise or a wrong output on patients headset and therefore the pos-
sibility of wrong client response.

@ WARNING! Do not place the system on or near equipment that generates a strong magnetic
or electrical field, as this may cause improper operation and interfere with the intended use of
the device.

RECOMMENDATION: To reduce the frequency of electrical shocks through ESD, the floors
should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the rel-
ative humidity should be at least 30%.

RECOMMENDATION: The quality of the mains power should be that of a typical commercial or
hospital environment.

@ WARNING! Use of this equipment adjacent to or stacked with other equipment should be
avoided because it could result in improper operation. If such use is necessary, this equipment
and the other equipment should be observed to verify that they are operating normally.

A WARNING! Use of accessories, transducers and cables other than those specified or
provided by the manufacturer of this equipment could result in increased electromagnetic emis-
sions or decreased electromagnetic immunity of this equipment and result in improper oper-
ation.

A‘ WARNING!: Portable RF communications equipment (including peripherals such as antenna
cables and external antennas) should be used no closer than 30 cm (12 inches) to any part of
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the System including cables specified by the manufacturer. Otherwise, degradation of the per-
formance of this equipment could result.

For more information on the conformance of the system with the EMC standard EN 60601-1-2,
refer to Appendix B.

8 Installation and Set-Up

This installation procedure assumes that you will make a full installation. Skip irrelevant parts,
if you are not going to install all the modules.

Be sure to observe the safety requirements stated in this document, both during installation
and whilst using the Fitting system’s instrumentation and transducers. Do not connect external
devices unless they are suitable for connection to the Fitting System.

8. 1 Hardware Setup

Note: No user-serviceable parts are found inside the Fitting Unit. Do not disassemble or modify
the unit!

8. 1. 1 Package and unpacking
External Inspection

Although your audiometer system parts were carefully tested, inspected and packed for ship-
ping, immediately examine the outside of the container after receiving the instrument for any
signs of damage. Notify your carrier if you observe any damage.

Unpacking

Carefully remove your audiometer system parts from its shipping container. If you observe any
mechanical damage, notify the carrier immediately so that a proper claim can be made. Be cer-
tain to save all packing material so that the claim adjuster can inspect it as well. As soon as the
carrier has completed the inspection, notify your Auditdata representative.

If the instrument must be returned to the supplier, repack it carefully (in the original container,
if possible) and return it prepaid to the supplier for the necessary adjustment.

Package contents
Check carefully that you have got all system parts according to the delivery note.

If any system part is missing or the delivery is not according to your order, notify your Auditdata
representative immediately.

8. 1. 2 Fitting Unit setup procedure

1. Unpack the Fitting System and cross-check that all ordered parts (as indicated on the
delivery note) are included. If any parts are missing, please contact your manufacturer for
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support immediately.
2. Slot the appropriate connector to your power supply.

3. Fasten the Fitting Unit on a wall, under a table or place it on a stable surface. (If con-
sidered more practical, the Fitting System can also be placed inside the audiometric
booth) or piggyback to the HIT unit.

Connect the USB cable to the inlet marked USB on the Fitting Unit.

Connect the other end of the USB plug into an empty slot on the operator PC.
Connect the power adapter to the DC inlet.

At the other end, connect the power plug to a power socket.

No ok

8. The plugs on the individual transducers come in specific colours, and should be plugged
into the connector marked with the same colour on the Fitting Unit. The name of the con-
nector is indicated next to the colour-marking on the Fitting Unit (see the table under the
picture).

2000 Primus Fitting Unit Pro, Primus PFU+
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Table: Connectors for use in the Fitting Name on the Fitting Unit (andlcol-
No Unit (plug/type in parenthesis) our of transducer connectors if
plug/type In p highlighted)
DC power adapter (pin/hole) DC power
USB cable (USB type B, 2.0) USB
21 Sony/Philips Digital Interconnect S/PDIF*3
Format
3 Free Field Speaker, left (passive type) Left
(Anitek, H5-02-1-0-5-0)
Free Field Speaker, middle (passive
4 | type) Mid
(Anitek, H5-02-1-0-5-0)
5 Free Field Speaker, right (passive type) Right
(Anitek, H5-02-1-0-5-0) &
. L x1*2
Free Field Line Out (3.5 mm Stereo Mini | Left/Right - Rear - Sub/Mid
6-8 | Jack for connecting active speakers or Line Out 1 - Line Out 2 - Line Out
amplifiers) 3*3
. *1*x2
o Client/Demo Headset (3.5 mm Stereo | Client Headset
Mini Jack) Demo Headset*3
10 | Option (DIN 8 pin) Option “2*3
11 Opera.tqr microphone, left (3.5 mm Ste- Left Operator Microphone
reo Mini Jack)
1 Operator.m.lcrophone, right (3.5 mm Connector not used
Stereo Mini Jack)
13 Ta.Ik_—back microphone(3.5 mm Stereo Talk Back Microphone
Mini Jack)
14 Operator hea(_js.et for monitoring (3.5 Monitor Headset
mm Stereo Mini Jack)
Air Conductor 1"
15 | Air conductor (DIN 8 pin) _*4
Air Conductor 3™
Air Conductor 174
16 | Alternative air conductor (DIN 8 pin) ‘4

© Auditdata - 2025, ID: 20.0109/24

19



Instructions for use

No

Table: Connectors for use in the Fitting
Unit (plug/type in parenthesis)

Name on the Fitting Unit (and col-
our of transducer connectors if
highlighted)

*4

17

High-frequency air conductor (DIN 8
pin)

Air Conductor 14
Air Conductor 274

Air Conductor 3

18

Bone conductor (DIN 8 pin)

19

Client Response push button (DIN 8
pin)/Free field calibration tool (DIN
8pin)

Client Response

20

Probe microphone set (DIN 8 pin)

*2

*3%4

*1 This plug is only available in the PFU.

*2 This plug is only available in the PFU+.

*3 This plug is only available in the Primus Pro.

4 Frequency above 8 kHz will be unavailable.

© Auditdata - 2025, ID: 20.0109/24
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Primus Ice

1 2 3 5 7 9 10 1
Table: Connectors for use in the Fitting Name on the Fitting Unit (andlcol-
No Unit (plug/type in parenthesis) our of transducer connectors if
plug/type in p highlighted)
DC power adapter (pin/hole) DC power
USB cable (USB type B, 2.0) UsSB
3 Free Field Speaker, left (passive type) Left
(Anitek, H5-02-1-0-5-0)
4 Free Field Speaker, right (passive type) Risht
(Anitek, H5-02-1-0-5-0) g
5 Ope_rator microphone (3.5 mm Stereo Operator Microphone
Mini Jack)
Free Field Line Out (3.5 mm Stereo
6 Mini Jack for connecting active speak- | Line Out/Demo
ers or amplifiers)
7 Tglk_—back microphone (3.5 mm Stereo Talk Back Microphone
Mini Jack)
3 Operator hea(_js.et for monitoring (3.5 Monitor Headset
mm Stereo Mini Jack)
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Name on the Fitting Unit (and col-
our of transducer connectors if
highlighted)

9 | Air conductor (DIN 8 pin) Air Conductor

High-frequency air conductor (DIN 8
pin)
10 | Bone conductor (DIN 8 pin) Bone Conductor

Client Response push button (DIN 8
11 | pin)/Free field calibration tool (DIN Client Response
8pin)

Table: Connectors for use in the Fitting

No Unit (plug/type in parenthesis)

Air Conductor+*1

1 Frequency above 8 kHz will be unavailable.

2000-1 Fitting Unit

I1 111

usB Right Left Line Out

/ @ 4_‘} Free Field Speakers SPDIF \
( ) R Client : ;
( Response
: .__O

B>
5 e—e

ey
G_

.
3 R e 4
\ AC HF
Meonitor Gpemtor
12 Headsel Mlcrophone 14
13 | Talk Back Ambient [ 15
/) Microphone Microphone
— I ———

Table: Connectors for use in the Fit- Name on the Fitting Unit (and
No colour of transducer con-

ting Unit (plug/type in parenthesis) nectors if highlighted)

1 Bone conductor (Mini DIN 8 pin) BC (Green)

2 Air conductor (Mini DIN 8 pin)

High-frequency air conductor (Mini
3 DIN 8 pin) AC HF (Yellow)
4 gl;:ol\i/rl];)robe microphone set (Mini DIN _

© Auditdata - 2025, ID: 20.0109/24 22



Instructions for use

Table: Connectors for use in the Fit- Name on the Fitting Unit (and
No ting Unit (plug/type in parenthesis) colour of transducer con-
g Unit (plug/type In p nectors if highlighted)
5 | Option (DIN 8 pin) Option (Purple)
Client Response Push Button (Mini
DIN 8 pin) OR
6 Client Response (Grey)
Free field calibration tool (Mini DIN 8
pin)
Free Field Speaker, right (passive . .
7 type) (Anitek, H5-02-1-0-5-0) Free Field Speakers, Right
Free Field Speaker, left (passive type) .
Free Fiel k Lef
8 (Anitek, H5-02-1-0-5-0) ree Field Speakers, Left
Free Field Line Out (3.5 mm Stereo
Mini Jack for connecting active speak-
9 ers or amplifiers) OR Line Out / SPDIF
SPDIF: Sony/Philips Digital Inter-
connect Format (toslink)
10 USB cable (USB type C) USB
11 DC power adapter (pin/hole) DC
12 Operator heangt for monitoring (3.5 Monitor Headset
mm Stereo Mini Jack)
13 Talk-b.ac.:k microphone (3.5 mm Ste- Talk Back Microphone
reo Mini Jack)
Operator microphone, left (3.5 mm .
14 Stereo Mini Jack) Operator Microphone
15 Connector not used Ambient Microphone
Hardware reset
16 Note: Perform only when instructed
by support or a technician.

9. Connect the speakers into the speaker inlets.

10. Optional: Connect the operator microphones, headset and additional freefield speakers

to the appropriate sockets.

11. Make sure that all cables are routed and fastened to prevent a hazard (such as entan-

glement) to personnel or clients.
12. Close the Fitting Unit using the lid.

© Auditdata - 2025, ID: 20.0109/24

23



Instructions for use

Note: The unit has no physical user interface (apart from the on/off lamp, which is visible
through the lid itself). Hereby, in order to protect it from dust and unintended disassembly, it is
recommended to keep the lid on during use.

8. 1. 3 2000-1 Fitting Unit Speaker Setup

The 2000-1 Fitting Unit (Measure audiometer) includes five speaker connection options: left
and right high-level speaker outputs, left and right low-level speaker outputs, and an Option con-
nector. The high-level and low-level outputs cannot be used simultaneously, which is also indic-
ated in the software.

Speaker Configuration:
¢ High-Level Outputs are intended for passive speakers without built-in amplifiers.

* Low-Level Outputs are suitable for external amplifiers or active speakers with built-in
amplifiers.

¢ The Option Connector is a single-channel high-level output that can connect to a regular
passive speaker using a special cable.

Units with serial numbers 330xxxxx

For units with serial numbers starting with 330, the low- and high-level outputs are not inde-
pendent channels: Sound routed to the high-level output will also be routed to the low-level out-
put.

The Option output is independent of the high-level output. However, it is not independent of the
low-level output: Sound played on the left/right low-level output will also be output on the
Option connector.

This means that a three-speaker setup is possible by connecting a pair of speakers (Left-Right)
to the high-level outputs, and a third speaker to the Option output.

Units with serial numbers 33 1xxxxx

For units with serial numbers starting with 331, the low- and high-level outputs are independent
channels: Sound routed to the high-level output will not be routed to the low-level output.

The Option output channel is independent from the high- and low-level speaker outputs.
8. 1. 4 Wireless Devices Setup

This chapter provides instructions for setting up wireless devices with the software.

WL REM Probe

The guidelines will assist you in charging, turning on, pairing, and understanding the status
indicators of these devices.
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Turning on the WL REM

The power switch is located on the left side of the REM Probe.

Power ON: Slide the switch up.

Power OFF: Slide the switch down.

Pairing the WL REM

The pairing button is located on the right side of the REM Probe.

To connect your device to the fitting unit:

1. Ensure the fitting unit is connected to power and your PC. Ensure no other wireless REM
is connected to the fitting unit.

2. Turn on the WL REM: if the switch was turned off, push it up to the "ON" position. Hold WL
REM close to fitting unit.
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3. Perform a long push on the button to enter pairing mode. The LED will blink blue, indic-
ating that the device is ready to pair.

4. Once the wireless connection is set, the LED indicator will turn green.

5. The software will display a message confirming a successful connection. The status bar
the software will also show the connected device's name and serial number.

NOTE: Ensure there is a clear line of sight between the WL REM and the fitting unit to maintain
optimal signal strength. Barriers between the WL REM and the fitting unit may impact com-
munication and degrade performance.

Charging the WL REM

The software provides a battery level indicator for connected devices. When the battery is low,
the LED will remain green, but a notification will appear in the software.

WL HDA-200 Low battery - X
Battery level: 5% Recharge device.

Status A WL HDA-200 Low battery x

To charge the WL REM:
1. Connect the USB charger to the USB connector at the bottom of the stand charger.

Place the REM Probe in the charger stand. The LED indicator will blink red one time and
will turn green again.
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To find the information on the battery status, go to Tools > Device Management > Wire-
less Devices in the software.

Sleep mode

Press & hold the button for 5 seconds to put the WL REM into sleep mode. The LED will change
from green to off (no LED).

If the WL REM has not been used for some time, it will automatically enter the sleep mode.
Push the pairing button to wake the device up from sleep mode.

Disconnection and Reconnection

¢ Disconnection Indicator:

If the device disconnects, the LED will turn off, and a notification will appear in the software:
"WL Real Ear Probe Not connected, WL Real Ear Probe S/N [xxxx] No longer connected. Please
reconnect to continue use."

e Reconnection Process:

To reconnect, turn the device off and on again. It will automatically attempt to reconnect to the
fitting unit.

Status Indicators Summary

Device Status LED Color
Power Off/Sleep mode No LED
Pairing Mode Blinking Blue
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Connected Solid Green
Start charging 1 Red Blink
Charging Solid Green

8. 1. 5 HIT Unit setup procedure

1. Place the HIT Unit on a stable surface.
2. Connect the USB cable to the inlet marked USB on the HIT Unit. Connect the other end

of the USB plug into an empty slot on the operator PC. Connect the power adapter to the

DC inlet, if performing tests are up to 16kHz.
3. To adjust hearing aid settings with HI-PRO or NOAHIink™, connect the HI-PRO box or

NOAHIIink™ to the appropriate INTERNAL HI CONNECTOR outlet using the extension
cables provided (as shown in the picture below).

HIT Box HIT Pro

DC  USB Left Right Monitor
o

4. Plugin the hearing aid programming lead to start programming with a HI-PRO or
NOAHIink™,

Note: You can also connect the HI-PRO box or NOAHIink™ directly to the operator PC.
The plug in the hearing aid programming leads directly to the HI-PRO box.
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HIT Box HIT Pro

5. Optional: Connect a monitor headset to the MONITOR socket.

HIT Box HIT Pro

DC UsB Left  Right Monitor Monitor  Left Right USB DC

Internal HI connector Internal HI connector

[ aleo @J [ oonJ

6. Plugthe reference microphone, coupler and battery pill in the inlets as shown below.
You can also place the necessary sponge provided to support the hearing aid. Please
refer to Section 9.2, Set up and editing for hearing instruments in the User Manual for
more information.

HIT Box HIT Pro
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No Name

1 | Coupler microphone

2 | Battery pill

3 | Hearing aid programming lead (HI-Pro cable)
4 | Reference microphone

5 | Hearing aid holder

6 | Coupler microphone holder

8. 2 Software Installation

8. 2. 1 Prerequisites

If you are using NOAH, version 4.7 or higher must be installed.

8. 2. 2 Installation Procedure

You will receive the software installation file on a USB memory stick. Insert the USB stick into a
USB slot.

To install the software:

1. Open Windows Explorer and locate the USB stick.

2. Locate the setup_x.x.x.x.exe file and double-click it.

3. Theinstallation program will now guide you through the installation procedure.
4. Follow the instructions on the screen.

Note: You will need to install an additional driver for the Video Otoscopy module. During the
installation of the software, you will be asked to allow the installation of these drivers. You must
click Install or the installation will be cancelled.

8. 2. 3 Updates

When a new software version is available, you can download it from the Internet. Open Audit-
data A/S' homepage, www.auditdata.com from the Support section.
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8. 3 Installing Your License

8. 3. 1 Cloud-based License Activation

The system automatically downloads and installs licenses from the cloud. Ensure the hardware
is connected to the computer and there is an internet connection. You will see a notification
once the license has been successfully added. To complete the installation, restart the applic-
ation.

8. 3. 2 Manual license activation

If the application cannot download the license from the cloud, you can manually enter the
license code:

1. Goto Help > License Information and choose the Licenses tab.

2. You have two options: Import and Enter Code.

Lom st brvie Licenses

c= Dy Moule

LA L Pl apgie sl A trow

e | oo Jeercone | e

¢ Click Import to navigate to the location of the license file, then click Open.

¢ If you have the license code, click Enter Code and enter your unique key, then
click OK.

3. Restart the application to complete the installation of the license.
8. 3. 3 Calibration and Adjustments

After completing the software installation and hardware setup, proceed to calibrate the free
field loudspeakers (if any) and make an initial adjustment of the attached microphones and
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headsets. After calibration and adjustment, the system is ready for use.

To view information on connected devices and calibrations, go to Tools > Device Management.

8. 4 Test Definitions Set-Up

Test definitions are pre-configured measurements based on the test types available within the
system. You can locate them by opening Tools and then clicking Test Definitions.

Use the Add, Edit and Remove buttons to set up test definitions for the main modules, namely:
Audiometry, Real Ear Measurement, Speech Mapping and HIT.

@ Test Definitions - 0O X
[ Test Definitions Pure Tone

@3 Pure Tone Name Description

i3 Speech NSE =
63 REM MCL
ucL

Remove

6% Speech Mapping
3 HIT

= Workflows

NCO u
CcL
CLA

53 Workflows
WBR

SISI
53 Set Password Stenger
8% Common

[ General

Close

You can create and name new custom test definitions for each measurement by configuring the
signal type, level, transducer, masking stimulus for each test.
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@ Editor For Test Definition X

General Frequencies Curve Styles Rules Masking assistant
Name [HTL |
Description H |

Test Type HTL

Stimulus Masking | Masking '|
Signal Type ‘ Pulsed Pure Tone v ‘ Signal Type | Narrowband Noise V|
Transducer ‘ Insert Earphone [NOT CONNE + ‘ Transducer | Insert Earphone [NOT CONNE ~ |
Interrupter ‘Sh’muli when pressed v ‘ Default Level, dB 50 .

Default Ear Side ‘ Right v ‘ Masking Side | Opposite v |

Level Preselection Other Settings
Start Level 50 . Step Level | 5dB V|
Reset Mode ‘ No Level Preselection v UCL Limiter | None v |
Reset Level .

|| Minimum point repetitions for threshold

Repetitions needed 2

1

dB Reset

o -]

Cor | o |

It is also possible to specify the completeness criteria by checking that the selected frequencies

are measured during the test.

Enable consistency criteria to check whether AC and BC thresholds need to be masked. Also,
check that the threshold levels are according to the following rule: UCL > MCL > AC >= BC.

v/ Enable mandatory frequencies check

Check that the following frequencies are measured:

[J125 [l 250 [v| 500 1750
13000 |+ 4000 (1 6000 (v 8000
["112500 "] 14000 [~ 16000

Consistency check

[+ UCL > MCL > HTL 2 BCL

|| Check that stimulus was played before store
|| Enable interoctave frequencies check

Check that the following frequencies are measured:

[ 1750 | 1500 [ 13000 |1 6000

|| Enable ambient noise monitoring warnings

Maximum permitted uncertainty

|| Stop measurement when ambient noise is high

o Editor For Test Definition X

General Frequencies Curve Styles Rules Masking assistant

[v/ 1000 1500 [+ 2000
|_I9000 [l 10000 111200

Threshold value dB HL
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More details about setting up various modules can be found in the System’s Help.

8. 5 Configuring Types of Visits

The Types of visits list itself is available right below the Client tab.

File View Tools Help

B0 &

® Doe John
0000002
6/1/1986

Male

First visit -

First visit
Follow-up Visit
Last Visit

HIT 1

HIT 2

e — =

The application is shipped with a set of predefined visits. You can add, delete or edit them. To
do this, open the Tools menu, click Settings, then Workflow in the General section, and use
Add/Delete/Edit buttons as needed.

If you do not wish to use some of the modules, you may disable it by deselecting the check box
under the Enable modules heading. Those modules will now not be shown in the workflow list
on the main screen.

Enable modules

v| Otoscopy

v| Tympanometry

v| Audiometry

v| Hearing Loss Simulator and Master Hearing Aid
v| REM

v| Speech Mapping

v HIT

Each task group consists of relevant tasks which you can select using the arrow buttons to
move to the selected tasks box to add to your workflow. Once you have selected all your tasks
required, use the Up and Down button to change the order of your selected tasks.
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In the main window of the application, the task groups are represented by the tabs located right
below the task list.
® Doe John

0000002

Male
37

‘ First visit v

I F Otoscopy

7 Tympanometry

LB
n F Pure Tone
= Speech

Audiometry tasks |
(( o [Simul....

3 & Master Hearing Aid

Q R REUR/REUG
) R REAR-65

ollo
J°

8. 6 Activating Workflow Support

The system includes a workflow support utility which guides you through the necessary meas-
urements step by step. The purpose is to provide the ability to follow company defined test pro-
tocols and open the particular test steps in their predefined configuration. For each workflow
step you can define type of measurement, stimulus, level, frequencies, etc. It is possible to set
each workflow step as an optional or mandatory step.

You can define as many workflows as you want depending on your needs. However, only one
workflow can be activated at a time.

To enable workflow support, go to Tools and select Settings where you click the Workflow tab.
Select the corresponding check box to activate workflow support.
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@ Settings
= General
i& Network
i§3 Common
3 Database
i@ Language
2 Client Information
@ Workflow
i§3 Measurement
8% Reporting

& CD and Media Files
Folders

i@ Key Mapping Manager

i& Loudspeaker selection
5 Got

2 GDT Interface

i@ Additional Information
[ Ambient Noise Monitoring

8 ANM Setup

i§3 ANM Default Values
= Audiometry

i@ Default Views

2 Controls

82 Measurement Standard

2 PTA/CPT

oo

" [ workflow Settings

System Settings
| Activate workflow support
Note: Activating workflow support will hide the short cuts selected for the types of visits and

will disable the selection below. Define Workflow steps from the Tools menu entry "Test
Definition".

Types of Visits
First visit (default)
Follow-up Visit
Last Visit
HIT1
HIT2

Enable modules

[v| Otoscopy

[v| Tympanometry

[v| Audiometry

|| Hearing Loss Simulator and Master Hearing Aid
(vl REM

[v| Speech Mapping

[w] HIT

Save Cancel

Note: Activating workflow support disables the types of visits functionality in the user interface.

To configure workflows, go to Tools -> Test Definition. Select a workflow entry from the list and
click Edit to open it. Use the buttons in the right panel to add new workflows, edit existing ones
or delete any workflow from the list.
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O Test Definitions - O

X

[ Test Definitions Workflows

1 Pure Tone Name Description Add

i83 Speech Basic Audiometry Test

i§3 REM Hearing Aid Transition

i@? Speech Mapping

82 HIT Up
= Workflows

Edit

Remove

:53 Workflows
5 General

83 Set Password

i@? Common

Close

To define the steps within the workflow, click the Edit button to open the configuration window.

€ Editor For Workflow

X

Workflow Name | Basic Audiometry Test

Description

Workflow Steps Name Description Mandatory

Pure Tone (AC)  Pure Tone testing via air conduction Yes

Edit

Pure Tone (BC)  Pure Tone testing via bone conduction Yes

. Remove
SRT Speech Reception Threshold test No

sD Speech Discrimination test No u

As you add the steps, you need to specify the test type, set its prospected duration and set test
step as mandatory or optional.

Note: There are three specific step types that display a message to the audiologist, prompt
them to enter a note, open an external file (website or presentation), called Display a message,
Prompt a user to add a note, and Open External Link correspondingly.

After restarting the software, you can find the workflow on the top panel of the application.
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an Fost Narre Provan 4
Lt N Aud Speech REM SM T
Gonder Nt g et

After the workflow support has been activated, click the Start button to begin. The first workflow
step will be highlighted and after clicking on it you will be directed to the corresponding module
and the preconfigured test will open up. Each step is coloured according to its state:

Yellow - Incomplete
Green - Done

Red - Skipped

Dark Grey - Active Step
Blue - Not Done

Workflow: Basic Audiometry Test | Finish | | Next Step *Pure Tone (A... - *pure Tone (BC) - SRT - SD I

If the criteria for the test type are not fulfilled, the application will notify you when you attempt
to move to the next step. You can see what criteria was not met and make required changes to
the measurement.

You must enter a reason why the criteria cannot be fulfilled or change the test to meet the cri-
teria requirements.

Note: Workflows must be completed on the same day. Data cannot be modified the following
day.

8. 7 Activating Transducers

The transducers used with the Fitting Unit need to be activated before usage. To start the activ-
ation:

Run the application.

Insert the transducer plug into the appropriate socket.
In the pop up window click Activate.

Your transducer is now activated.

PONPE

8. 8 Connecting Transducers to a Sound Booth

To connect a transducer to a sound booth, please do the following;:
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Run the application and plug in the transducer into the Fitting Unit.

Disconnect the transducer. Do not restart the software.

Plug in a sound booth cable into the same plug that was used for the transducer.
The system will show the dialog with data from the last connected transducer.
Verify that the right transducer is connected.

You can now connect your transducer to a sound booth.

SRS RINES

8. 9 Calibration of Free-Field Loudspeakers - Sound Field Cal-
ibration

Free-field loudspeakers must be calibrated before performing any audiometric testing.

The calibration of the free-field loudspeakers is only valid for the exact distance from the cli-
ent's ear for which they are calibrated at.

Therefore, free-field loudspeakers should be re-calibrated if they are moved from the exact loc-
ation at which they were calibrated.

For the following procedure it is assumed that the connected loudspeakers are of a high quality,
particularly with respect to linearity and maximum sound pressure.

Procedure

1. Place the free-field loudspeakers at a distance no further than 1 m and angle the speak-
ers, for example at 45° or 0° azimuth from where the client's ear will be during tests. The
center of the loudspeaker should be at the same height as the ear canal.

Note: The calibration must be repeated if the client has moved from the original calibration
distance.

2. Inthe case of active loudspeakers, make sure that the volume is set to maximum.

Note: Some active loudspeakers may be too sensitive and will produce distortion noise,
when set at maximum volume. In that case, try to reduce the volume (if max. output can be
reached) until you find a level where max. output level can still be reached and noise from
the loudspeaker system is acceptable.

3. Open the Fitting System program, go to Tools > Settings > General > Loudspeaker selec-
tion and select the correct speaker for pure tone, speech, REM, and SM according to your
setup.
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- 0O X

Workstation Settings

A | ‘ Left and Right Speakers

v | ‘ Left Speaker

v | ‘ Right Speaker

v | ‘ Right Speaker

0 Settings
[ General Loudspeaker selection

@ Network

Pure tone ‘ Free Field Loudspeakers
i?}'i Common
@ Database Speech ‘ Free Field Loudspeakers
8 Language REM ‘ Free Field Loudspeakers
8% Client Information SM ‘ Free Field Loudspeakers
¢ Workflow Percentile Free Field Loudspeakers

@ Measurement
@ Reporting

@ CD and Media Files
Folders

[v| Play Windows sounds through speakers

[v| Room Equalization in REM

@ Key Mapping Manager

i@ Loudspeaker selection

4. Click Save to confirm the specified settings.

‘ Right Speaker

5. Select Sound Field Calibration from the Tools menu.

6. The window contains the history of performed calibrations. Click Do Calibration to start a

new calibration.

Note: A password is required to access this function. Enter the following password -

"orimusFFcal".

7. Inthe Calibration of Free Field Loudspeakers dialogue box, enter the name of the tech-
nician who performs the calibration, select the module you want to calibrate and a cal-

ibration method.

@ Calibration of Free Field Loudspeakers X

Technician Name |Jennifer Hutchinsor{

Select modules for calibration:
|v| Pure tone audiometry
|| Speech audiometry
|| REM/SM

Select Calibration Mode

Using REM reference microphone
® Using free field calibration tool

) Using external SPL meter

For wireless REM, ensure to select Wireless REM reference microphone dynamic option
which appears if the device is connected at the start of calibration.

8. If you have selected external SPL meter, in the next Setup window, select the speakers you

wish to calibrate.
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10.
11.

12.

13.

14.
15.

Also check-mark the box at the bottom if the calibration should include the high-frequency
area.

Note: High frequency calibration option is only available when the pure tone audiometry
module is selected.

If you are using the built-in microphone, select Left or Right Probe-mic to measure the
levels with.

Note: The REM probe microphones must be calibrated before being used to calibrate the
loudspeakers.

If you are using the free field calibration tool, levels will be measured with the free field cal-
ibration microphone.

Note: When using the Primus Ice, you should calibrate by selecting the external SPL meter
or the free field calibration tool.

Set the level you wish to calibrate at.
Select Speech Noise- ILTASS for signal for sound card calibration.

Place the SPL meter, free field calibration microphone, or Real Ear Probe at the exact loc-
ation where the client's ear will be tested.

Observe the instructions at the top of the Setup window, and click the Start button. (You
will get a warning, if any selected instruments are not connected and turned on).

If you use the SPL meter, you will need to set the level manually, using the correction val-
ues shown in the image below. If you want to add 2 dB to the level, for example, just press
+1 twice. Once you are fine with the level, click the Next button.

When using "Built-in Microphone" or free field calibration tool, and more than one speaker
were selected, the procedure will continue automatically for other loudspeakers. If one or
more frequencies cannot be calibrated, a warning will appear. At the end of the calibration
a report will be displayed, showing any uncalibrated frequencies or levels.

Click OK to save the calibration and exit the Loudspeaker Calibration dialogue box.

By means of markings or fastening, make sure that the loudspeakers will be placed in this
exact position compared to the client's location during testing.

You can import and export calibration data in the XML format using the Import and Export but-
tons correspondingly. After you click Import, locate the saved calibration XML file on your PC
and click Open. Proceed to calibration afterwards. To export your calibration data, click the
Export button and save the XML file to your local computer.

Use the Print Report button to print the calibration report.
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8. 10 Addition of External Sound Files for Speech Audiometry
and Speech Mapping

To add a new media files folder:

1. Onthe CD and Media Files Folders, click Add button to add a new folder with your own
sound files (wav, ogg, wma) or get the files from the Cloud. The Custom Media files
Folder window opens.

2. Specify the Name of the external folder.

¢ If you are planning on using the speech materials from the Cloud, activate the cor-
responding option.

3. Select the Folder Path where the external folder is located.

4. Select the CD Scheme that corresponds to your sound files and click the Calibrate but-
ton.

5. Select the track or special sound which will calibrate your sound files.
6. Calibrate the selected files and click Save button and then OK to save again.

The calibration of recently calibrated file will be used for all external sound files in Speech Map-
ping and Speech Audiometry modules.

Note: Only one calibration value is available and used for all external sound files and will be
applied to all transducers.
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8. 11 Calibrating Speech CD Material

To adjust the output level for speech material:

1.
2.
3.

5.

6.

Select Settings from the Tools menu.
In the Settings dialogue box, select CD and Media Files Folders from the General folder.

In CD and Media Files Folders Settings, click the button Calibrate CD... to open the CD
Calibration window.

Adjust the CD Offset to the correct value in dB if the CD contains an offset value.

The value in the field “CD Offset” has only effect on the free field speakers, but not on the
transducers. It will increase or decrease the common reference output level for the sound
field speakers according to the value entered. A change of the offset value does not influ-
ence the VU meter level displayed.

Important Note: The required CD offset value should only be obtained in conjunction with
a proper calibration equipment (sound level meter) to measure the output level of the
sound field speaker.

Warning: Only recorded speech material with a stated relationship with the calibration sig-
nal should be used.

Select the calibration track on the CD and click Start Calibration.

O calibration dialog X

Select CD track for calibration:

Disk ‘ © Calibration '|

Track ‘Calibration 0:48 v|

CD offset E

Right | ! |
-40 -30 -20 -10 0 10

Left | ]
-40 -30 -20 -10 0 10

T

During the calibration adjust the level so the VU meter is around O using the ‘+’ and ‘-’ but-
tons.

Click Save to save the setting and exit the dialogue box.
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8. 12 Selecting Client and Entering Client Data

If client data has been saved in the Noah database, the client's name will appear in Noah’s
Patient Browser.

To start the program as a Noah module, you have to select the client in the Patient Browser and
then click the software icon in the module list.

The application opens with the client's data displayed in the dashboard of the application.

If you need to create a client in Noah, open the Noah File menu, click Add New Patient, and
then fill in the client data. Please note that fields marked in orange are mandatory.

If the application has been started outside the Noah system, you have to enter the client’s data
first. Open the Tools menu, click Client Information, and then fill in the client data.

Once you click OK, the client’s name, date of birth and some other data will appear in the top
title bar. To choose which information to display in the title bar, go to Settings > General > Cli-
ent Information and select the appropriate checkboxes.

O settings - 0O X
= General Client Information Settings
83 Network User Settings
Fields on First Tab
@ Common
5 Datab First Line Client Number v
atabase
&2 Client Information Third Line Age -
@ Workflow - - -
Title bar information
@ Measurement
v| Show client name
Reporti
&2 Reporting v/ Show client number
& CD and Media Files Show NHS number
Folders
v Show birthday
i@ Key Mapping Manager

Alternatively, you can import client data that were previously exported from the application:
open the File menu, click Import Sessions and then specify the location of the XML file with the
client data.

8. 13 Obtaining Hearing Threshold Levels

Prior to performing audiometric measurements with your client, please ensure the following:
For the client:

1. The client has a comfortable seating in the sound-attenuating booth.

2. The appropriate testing headsets are plugged into the appropriate sockets.

3. Aclient response switch is connected to the CLIENT RESPONSE socket of the Fit-
ting Unit.

4. Optionally, a microphone for the client talk-back is connected to the TALK BACK
MICROPHONE socket on the Fitting Unit.
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For the operator:

1. Optionally, a monitor headset with boom microphone can be connected to the

MONITOR HEADSET socket of the Fitting Unit for talk-back monitoring.
2. Optionally, a separate microphone is connected to the OPERATOR MICROPHONE

socket for talk-over monitoring.

Click on the icon on the Audiometry tasks tab in the application to open the Audiometry front
page in the dashboard.
® Doe John 4
0000002
Male
37

‘ First visit v

|l F Otoscopy

EI R Tympanometry

p-mm_-N

n R Pure Tone
F Speech

.
(( 5 Simul...

L
== IS Master Hearing Aid
Q R REUR/REUG
o) R REAR- 65
ollo
K

Click the Pure Tone Measurement button (| Pure Tone Measurement |) in the Audiometry pane of the
dashboard to open the Pure Tone Measurement window.

Make sure that HTL is selected in the Test Types panel in the top left corner of the window.

o Pure Tone Measurement

()v % @ v m [ JSNCULEGENCM 5 dB Steps v [ None

4 Test Types Right Ear

O X HTL -10 HTL——2
MM McL / : ECL

U U uc ¢

< > BCL 10 /
S S FF = ¢

@ % FF-A

O X WBR 30

®® Stenger

Add measurement ... ¥

20

To select the HTL test type, simply click it. Alternatively, you can press the T button on the key-
board.
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Check the settings on the Measurement Controls panel below the audiograms:

1. Select ear by means of the blue (@ ) or red button (@ ). Alternatively, use the L button

on the keyboard for the left ear and the R button for the right ear.
2. Set frequency and amplitude by means of the "+" and "-" buttons. Alternatively, use the

arrow left/right and up/down buttons of the keyboard.
3. Configure the necessary masking settings.
4. If you need to adjust the talk-over/back levels, click the Settings () button to open

this setting menu.

For a complete list of keyboard shortcuts, please refer to the Help file. To open it, go to the Help
menu of the application and click Get Help; alternatively, press F1 on the keyboard.

Click the Stimulus button, or press the spacebar on the keyboard, to present a signal to the cli-

ent. When the client is capable of catching the signal of a certain frequency and level, he or she
responds by using the response switch. When this happens, the colour of the Frequency Levels
pane changes.

| Right Insert [NC] v ‘ | Left Insert [NC] |
-5deHL T 1000 Hz ®
| Pulsed Pure Tone A ‘ | Narrowband Noise '|

Click the Store button, or the S button on the keyboard, to mark the point in the audiogram.
Refer to the Help file for a detailed description of the procedure.

When you have obtained all required data for both ears, click Save—the button is active if the
program is opened as a Noah module—and then Close, in order to save your measurement
data.

After that, a corresponding item appears in the Measurement History pane of the dashboard. If
you place the mouse pointer over the history item, the corresponding audiogram will be shown
in a large format.
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e Measure
File View Tools Help

® 0 AHa @
®b

Audiometry
Date: 9/13/2023 3:43:00 PM

oo b

= Pure Tone
e g

—M 26
20 ©
ﬂ . 30 m\\( -
Note: o

(0 Measurement Histol
©, o

Latest v

70
Q’\ 9/13/2023  Pu

3:43:00 PM g

TH

dB HL

olln o
110
Chyte
:m 120
No
125 250 500 1K 2K aK 8K
Frequency
2/21/2023 Pui
10:42:56 PM
X HTL PTA: 23
® Stenger

You can double click any measurement from the session list to display it in the workspace.

From the Measurement History pane, it is also possible to print a selected measurement by
employing the corresponding button.

The Print option enables printing reports for the current or any of the older sessions. For REM,
SM and HIT measurements, the only default report type will be printed. As for the Audiometry
Reports, you can choose between a number of available options in the Print Options section
that is accessible via Settings > General > Reporting.
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8. 14 Shutdown Procedure

Closing Application
To safely close the application:

1. Select File > Exit or use Alt+F4. If you made any measurements, the system will show
the warning:

@ Warning X

The application contains unsaved data.
Do you want to save the data before
you exit?

I T

2. Click Yes to save the session data and close the application. Click No if you want to close
the application without saving of data.

Disconnecting Fitting and HIT Units

For the Unit that uses the Opto-USB cable without power DC adapter: disconnect the USB cable
from the instrument and the USB power supply from the mains power outlet.

For the Unit that uses DC adapter and non-optical USB: disconnect the USB cable from the
instrument and then disconnect the DC adapter both from the instrument and the mains power
outlet.

For the Unit that uses non-optical USB without power DC adapter: disconnect the USB cable
from the instrument.

For the Unit that uses the Opto-USB cable and power DC adapter: disconnect the USB cable and
the USB power supply from the mains outlet and then the power DC adapter from the instru-
ment and the mains power outlet.

9 Maintenance

9. 1 Annual Calibration of Headset and Transducers

The headset and transducers delivered with the Fitting System and reference and coupler
microphones delivered with the HIT Unit are NOT intended for calibration by users. Contact your
local distributor for your annual service and calibration.

9. 2 Adjustment of Common Headsets and Microphones

All calibration of the Fitting System and the transducers delivered with it has been performed by
the manufacturer before shipment. The system’s accessories should be re-calibrated annually
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by the supplier or their appointed representatives to ensure system integrity.

However, depending on your license agreement, you may have access to perform calibrations
locally. In this case, additional options such as Headphones Calibration, REM Calibration, and
HIT Microphone Calibration can be done using a separate calibration tool.

9. 3 Regular System Checks
9. 3. 1 Daily Equipment Checks

Regular equipment checks ensure accurate and reliable test results. While the following
guidelines provide a general procedure, always refer to official standards applicable in your
region to ensure compliance with legal and clinical requirements.

Daily checks are particularly important for clinicians who frequently transport their equipment.
Movement and handling can lead to subtle damage or misalighnment, making routine veri-
fication essential to maintain performance consistency.

Conduct equipment checks in an environment with noise levels similar to actual test con-
ditions to ensure accurate results.

Daily Equipment Check Procedure

Step 1: Inspect and Clean

e Examine the audiometer and all accessories for wear, dirt, or damage. Pay close attention

to earphone cushions, plugs, wires, and connectors.
e Clean components. For detailed cleaning instructions, refer to Cleaning.
¢ Replace any damaged or worn parts before proceeding.

Step 2: Warm-Up

e Turn on the equipment and allow it to warm up for five minutes before use (minimum one

minute).
e Forrechargable devices, check the battery level and recharge if necessary.

Step 3: Verify Components

¢ Match transducer serial numbers with software records.
* Inspect all cable connections (plugs, wires, junction boxes) to ensure proper setup and

stability.
* Resolve any intermittent issues before testing.

Functional Tests
Step 4: Low-Level Sound Check

¢ Play tones at low hearing levels (10-15 dB HL) across all test frequencies.
» Verify audibility for air and bone conduction.
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¢ Listen for noise, hum, breakthrough sounds, or tone changes when applying masking
noise.

Step 5: High-Level Sound Check

e Set hearing levels to:
Air conduction: 60 dB HL

Bone conduction: 40 dB HL
¢ Ensure clear sound, no distortion, and proper transducer operation.

Physical Tests

Step 6: Transducer Inspection

¢ Check the tension of headsets and bone conduction headbands.
¢ Ensure that swivel joints move smoothly, neither too loose nor too stiff.
* Look for signs of wear, strain, or metal fatigue on cables and headbands.

Step 7: Audiometer Inspection

¢ Ensure no extraneous instrument noise is present when the device is idle.
¢ Confirm all cables and connectors are securely attached, without visible cracks or fraying.
¢ Verify the attachment between the audiometer and any external components, such as

sound booth cables.
¢ Gently move cables to check for signal interruptions, which may indicate loose or dam-

aged connections.

9. 3. 2 Adjusting Speech Audiometer input level

To ensure proper sensitivity levels during daily checks, it is recommended to verify the VU-
meter. For this, you should play a CD calibration signal and adjust the input sensitivity to O
dBVU.

9. 3. 3 Calibration of probe tube and reference microphone (in REM and SM)

Prior to real ear measurement session or when replacing the probe tube with a new one, ensure
the correct probe tube calibration. If it is calibrated properly, you should see a flat curve once
measuring a REUG with the probe tube still kept in the calibration position.

9. 3. 4 HIT box calibration

On a regular basis (e.g. once per day), check the proper coupler microphone sensitivity and cal-
ibration. The procedure is as follows:

1. Unscrew the coupler microphone body to expose the coupler microphone diaphragm.
2. Place it close against reference microphone without it touching.

3. Conduct an OSPL90 measurement, you should see a flat line at 90 dB.
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9. 4 Inspection

On a regular basis, that is, at least once a week, perform a visual inspection of the Fitting and
HIT Units and their accessories for visible damages. During use, evaluate the test results and
perform a system inspection if the results appear unreliable.

9. 5 Cleaning
9. 5. 1 Disposable parts

@ Parts such as foam tips on insert earphones or probe tubes for real-ear measurement are
not intended for reuse. Dispose of such items in a hygienic manner after each client session.

9. 5. 2 Reusable parts

Maintain a high level of hygiene and clean reusable devices which come into contact with cli-
ents between each use. See the cleaning instructions below.

9. 5. 3 Cleaning instructions

e For cleaning use only a soft dry cloth dampened very sparingly with a low level dis-
infectant solution such as isopropyl alcohol to wipe the device. Do not allow excess solu-

tion to enter the device as this may damage internal components.
¢ Do not autoclave, pressure sterilise, or gas sterilise the device or any of its electrical

accessories.
e Do not soak or immerse the device in any liquid.
¢ Do not use acetone or paraffin/kerosene-based solutions, or any other harsh solvent to

clean the device or its accessories. Use of such substances may be harmful to the equip-
ment and may result in faulty operation.

9. 6 Switching to a New Transducer

When setting up a new transducer, make sure that it is recognized by the Fitting Unit. To do so,
follow the instructions:

1. Connect the Fitting Unit to the PC using the USB cable.
2. Start Measure.

3. Wait until the Fitting Unit is initialized and connected. The current connection status is dis-
played on the right side of the status bar at the bottom of the screen.

Disconnect the old transducer.
Connect the new transducer to the Fitting Unit.

In Measure, go to Tools > Device Management.

N o o &

Review the name and serial number of the new transducer.
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If the data corresponds to the new transducer, you can start using the system normally.

If the data corresponds to the old transducer, proceed with the next steps.
8. In Measure, go to Tools > Refresh Transducer Data.
9. Select the needed transducer and click Refresh Transducer Data.

10. The system will inform you once the process is finished. You can close the window and
start using the system normally.

9. 7 Securing Patient Data

Protecting patient data is crucial for maintaining confidentiality and complying with legal and
ethical standards. Implement the following measures to enhance data security:

1. Enable Password Protection: Set up strong, unique passwords for all devices and soft-
ware handling patient information. This adds a critical layer of defense against unau-
thorized access.

2. Implement Data Encryption: Utilize encryption tools to protect sensitive data stored on
devices. Encryption ensures that even if data is accessed without authorization, it
remains unreadable.

3. Secure Data Backups: Regularly back up patient data to secure, access-controlled loc-
ations. Avoid using unsecured external drives or cloud services without proper encryption
and security protocols.

4. Maintain Updated Software: Keep all operating systems, applications, and security soft-
ware up to date to protect against vulnerabilities and exploits.

5. Implement User Access Controls: Restrict access to patient data based on user roles
and responsibilities. Ensure that only authorized personnel have access to sensitive
information.

6. Utilize Secure Networks: Ensure that data transmission occurs over secure networks.
Avoid using public or unsecured Wi-Fi networks when accessing or transmitting patient
information.
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10 Troubleshooting Guide

If you have any problems with installing or running the software, please go through this guide

first before contacting Support.

Please verify that the following installation prerequisites are satisfied:

¢ The Fitting System software supports Windows 10, Windows 10 Anniversary Update and

Windows 11 operating systems.

e Local administrator rights are required in Windows to install the Fitting System software.

¢ The Fitting System software supports NOAH 4 or higher.

Before starting the troubleshooting - please ensure that you do the following steps:

Re-start the computer.

ting/HIT unit.

Unplug the USB cables and power supply (if available) from the Fitting/HIT unit.
Connect the Fitting/HIT unit to the computer using the USB cable.

Connect the power supply to the Fitting/HIT unit, if available.
Check that all available headsets, speaker and other accessories are connected to the Fit-

Run the Fitting System software.

¢ Check that the Fitting/HIT unit is connected properly:
* |n the Fitting software status bar the device is shown as Connected:

Status @ PFU+ HW: Connected 9 HW: Not Connected

e Power light on the Fitting/HIT unit is permanently on.

If any of the above steps failed, please refer to the below table for the solution of your problem.

Problem

Action

Software installation problems

e Setup can’t be completed
successfully (when running
the setup_x.x.x.x.exe).

¢ Use only the supported Windows operating sys-

tems.
¢ Use the latest Windows service packs.

Software set-up problems

e The stimulus button in the
Audiogram is greyed out.

¢ At start-up of the Fitting Sys-
tem the “License noti-
fication” message is shown.

¢ The License code is not activated. Please activate
the license from the help menu and follow the
description for the activation of the license code.

Hardware connection problems

¢ In the Fitting Software Sys-
tem’s status bar under
“AUD HW/ HIT HW” it says:
“Not connected”.

¢ Reconnect a USB cable and power supply, if avail-
able. Check that the units are connected. (See the
status bar in the software).

¢ Try another USB port on the computer.
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Problem

Action

e Try another USB cable.
¢ |f connection is done via hub/switch, connect dir-

ectly to computer.

¢ No sound in headset or
speakers, etc.

e Ensure that the unit is connected to the computer

using the USB cable.

e Power light is steady on.

¢ Plug and unplug all headsets.

¢ Reconnect USB cable and power supply, if avail-
able. Check that the units are connected. (See the
status bar in the software).

¢ No output from the speaker
in REM.

Ensure that you have selected the correct speaker in the
Tools > Settings > General > Loudspeaker selection >
REM. Then calibrate your REM probe tube.

e Power light is not steady at
start-up of the Fitting Soft-
ware System.

¢ Re-start the Fitting Software System.
e Reconnect USB cable and power supply, if avail-

able. Check that the unit is connected. (See the

status bar in the software).
¢ Check that the unit is displayed in Windows device

manager under sound devices. If not, please con-
tact support.

* Need to reset the instru-
ment.

If a HW reset is required, follow these steps:
1. Close the software,

2. Disconnect all transducers, accessories, and
cables from the instrument.

3. Locate the small reset hole on the rear of the instru-
ment.

10 11 7 8 9
UsSB bc Right Left  Line Out
. G Free Field Speakers SPDIF .
1e—/ r & r 6
| BC Client |
|
\ . °

Respanse

. \
— )8 *G—r
-l .
| |

| Monitor Operator /~ ‘
12._|_a\ . ( ; y 014
“ ./ Headset Mlcmphonc\k/ “
\ |
\

\
\ e
Talk Back Ambient
13 Ay \jj Mau:rn:;ane Micm"[;n:r'\‘b ‘k;/ 7 15

_— -

16 - Hardware reset in 2000-1 Fitting Unit
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Problem

Action

4. Insert a paperclip into the hole until you feel a light
click.

5. Hold the paperclip in place and connect the USB
cable without removing it.

6. Wait for the instrument to blink a few times then
remove the paperclip.

7. Restart the software.
After restarting, the instrument will prompt for an update.

Note: Perform only when instructed by support or a tech-
nician.
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11 Hotline and Technical Support

Auditdata A/S, Wildersgade 10B, 1408 Copenhagen, Denmark. Phone +45 70 20 31 24 sup-
port@auditdata.com

UK Responsible Person:
Auditdata Ltd., Staines-upon-Thames, UK. Phone +44 (0) 333 4444 212.

support@auditdata.com

Australia Sponsor:
Daryl Staley-Jackson, 247 Creek Ridge Road, Glossodia, NSW, 2756, Australia.

support@auditdata.com

US:
Auditdata, LLC, 88 Glocker Way, #352 Pottstown, PA 19465. support@auditdata.com
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Appendix A

A.1 Declarations of Conformity
Primus Fitting Unit+ (PFU+)

Auditdata
DECLARATION OF CONFORMITY

REGULATION (EU) 2017/745 OF THE EUROPEAN PARLIAMENT

Manufacturer name and Auditdata A/S
address Wildersgade 10B
1408 Copenhagen
Denmark
Notified Body name and TUV SUD Product Service
address GmbH C E
Ridlerstrasse 65 0123
80339 Munchen
Product Identification MD Category: Hearing Medical Diagnostic (Hardware
and Software)
Trademark: Primus PFU+
Type/Model: Primus Fitting Unit - PFU+ (PFU+)
CS (Common specification) N/A no common specification has been
published
SRN: DK-MF-000011415
Basic UDI/DI: 05711781DHF2000ZC
Risk class: lla, rule 10
Lot/Batches/Serial All issued serial numbers from
number: 21000001
Intended purpose Audiometer is a device used for evaluating hearing acuity. The

audiometer records the subject's responses to produce an audiogram
of threshold sensitivity, or speech understanding profile. Audiometer
with stated accessories is indicated for non-continuous, noninvasive
air and optionally bone conduction and speech audiometric testing.
Audiometer is indicated for non-continuous real-ear measurements
(REM) at the ear drum by means of noninvasive external ear canal
insertion of a probe tube.

Conformity assessment Annex IX (Quality system and technical documentation assessment)
EC-Certificate No.: G10 076081 0015
DOC valid until 2029-02-18

This declaration of conformity is issued under the sole responsibility of Auditdata A/S.
We hereby declare that the medical device specified above Is in conformity with the
European Regulation (EU) 2017/745 and Directive 2011/65/EU.

Copenhagen, February 19t 2024

Denys Lebedev, QA/RA Manager
X o

v .
/ 1/
! %‘
%

/

1D: 30.0241/09
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2000 Primus HIT Pro

Manufacturer name and
address

Notified Body name and
address

Product Identification

Intended purpose

Conformity assessment

Auditdata
DECLARATION OF CONFORMITY

REGULATION (EU) 2017/745 OF THE EUROPEAN PARLIAMENT

Auditdata A/S
Wildersgade 10B
1408 Copenhagen
Denmark

Danish Health and
Medicines

Authority

Axel Heides Gade 1
2300 Copenhagen S,
Denmark

MD Category:
Trademark:
Type/Model:

CS (Common specification)

SRN:
Basic UDI/DI:
Risk class:

Lot/Batches/Serial
number:

C€

Hearing Medical Diagnostic (Hardware)
Primus HIT

2000 Primus HIT Pro (Unit), 2005 -1 HIT
Unit

N/A no common specification has been
published

DK-MF-000011415
05711781DHF2000ZC

I, rule 13

All issued serial numbers from
32000001

The HIT Unit is intendent to apply sound to the hearing aid in a closed
test box and obtain the acoustical output of the hearing aid in a
coupler cavity equipped with a microphone.

The HIT Unit is intended to be used together with the Software to
provide objective indication of the characteristics of a Hearing Aid.
Visualization of the obtained coupler microphone signal is only
available in the Software application.

The HIT Unit is indicated for technical quality inspection or fitting of
hearing instruments with no clients involved.

Annex |, Il and 111

This declaration of conformity is issued under the sole responsibility of Auditdata A/S.
We hereby declare that the medical device specified above Is in conformity with the
European Regulation (EU) 2017/745 and Directive 2011/65/EU.

Copenhagen, May 26t 2024

Denys Lebedev, QA/RA Manager

ID: DN00969/06
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2000 Primus Fitting Unit Pro

Auditdata
DECLARATION OF CONFORMITY

REGULATION (EU) 2017/745 OF THE EUROPEAN PARLIAMENT

Manufacturer name and Auditdata A/S
address Wildersgade 10B
1408 Copenhagen
Denmark
Notified Body name and TUV SUD Product Service
address GmbH
Ridlerstrasse 65 0123
80339 Munchen
Product Identification MD Category: Hearing Medical Diagnostic (Hardware
and Software)
Trademark: Primus Pro
Type/Model: Primus Fitting Unit Pro (2000 Primus

Fitting Unit Pro, PFU Pro)
CS (Common specification) N/A no common specification has been

published
SRN: DK-MF-000011415
Basic UDI/DI: 05711781DHF2000ZC
Risk class: Ila, rule 10
Lot/Batches/Serial All issued serial numbers from
number: 25000001
Intended purpose Audiometer is a device used for evaluating hearing acuity. The

audiometer records the subject's responses to produce an audiogram
of threshold sensitivity, or speech understanding profile. Audiometer
with stated accessories is indicated for non-continuous, noninvasive
air and optionally bone conduction and speech audiometric testing.
Audiometer is indicated for non-continuous real-ear measurements
(REM) at the ear drum by means of noninvasive external ear canal
insertion of a probe tube.

Conformity assessment Annex IX (Quality system and technical documentation assessment)
EC-Certificate No.: G10 076081 0015
DOC valid until 2029-02-18

This declaration of conformity is issued under the sole responsibility of Auditdata A/S.
We hereby declare that the medical device specified above Is in conformity with the
European Regulation (EU) 2017/745 and Directive 2011/65/EU.

Copenhagen, February 19t 2024

Denys Lebedev, QA/RA Manager

o~

ID: DN01781/02
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2000 Primus Audiometer Unit Ice

Auditdata
DECLARATION OF CONFORMITY

REGULATION (EU) 2017/745 OF THE EUROPEAN PARLIAMENT

Auditdata A/S
Wildersgade 10B
1408 Copenhagen
Denmark

Manufacturer name and
address

TUV SUD Product Service
GmbH

Ridlerstrasse 65

80339 Munchen

Notified Body name and
address

Product Identification MD Category:

Trademark:
Type/Model:
CS (Common specification)

SRN:
Basic UDI/DI:
Risk class:

Lot/Batches/Serial
number:

Intended purpose

C€ .

Hearing Medical Diagnostic (Hardware
and Software)

Primus Ice
2000 Primus Audiometer Unit Ice

N/A no common specification has been
published

DK-MF-000011415
05711781DHF2000ZC
lla, rule 10

All issued serial numbers from
26000001

Audiometer is a device used for evaluating hearing acuity. The

audiometer records the subject's responses to produce an audiogram
of threshold sensitivity, or speech understanding profile. Audiometer
with stated accessories is indicated for non-continuous, noninvasive
air and optionally bone conduction and speech audiometric testing.

Conformity assessment

EC-Certificate No.:
DOC valid until

G10 076081 0015
2029-02-18

Annex IX (Quality system and technical documentation assessment)

This declaration of conformity is issued under the sole responsibility of Auditdata A/S.
We hereby declare that the medical device specified above Is in conformity with the
European Regulation (EU) 2017/745 and Directive 2011/65/EU.

Copenhagen, February 19t 2024

Denys Lebedev, QA

e

Py,
e

-

/

A
W
Fibd

/RA Manager

ID: DN00625/07
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2000-1 Fitting Unit

Auditdata

DECLARATION OF CONFORMITY

REGULATION (EU) 2017/745 OF THE EUROPEAN PARLIAMENT

Manufacturer name and Auditdata A/S

address Wildersgade 10B
1408 Copenhagen
Denmark

Notified Body name and TUV SUD Product Service
address GmbH

Ridlerstrasse 65

80339 Miinchen

Product Identification MD Category:

Trademark:
Type/Model:
CS (Common specification)

SRN:
Basic UDI-DI:
Risk class:

Lot/Batches/Serial number:

CE€ o

Hearing Medical Diagnostic
(Hardware and Software)

Measure, Unity 4

2000-1 Fitting Unit (2000-1 FU)
N/A no common specification
has been published
DK-MF-000011415
05711781DHF2000ZC

lla, rule 10

All issued serial numbers for

2000-1 FU from 33000001

Audiometer is a device used for evaluating hearing acuity. The
audiometer records the subject's responses to produce

an audiogram of threshold sensitivity, or speech understanding
profile. The 2000-1 FU with stated accessories is indicated for
non-continuous, noninvasive air and optionally bone conduction
and speech audiometric testing. The 2000-1 FU is indicated for
non-continuous real-ear measurements (REM) at the ear drum by
means of noninvasive external ear canal insertion of a probe tube.

Annex IX (Quality system and technical documentation
assessment)

Intended purpose

Conformity assessment

EC-Certificate No.: G10 076081 0015
DOC valid until 2029-02-18

This declaration of conformity is issued under the sole responsibility of Auditdata A/S.
We hereby declare that the medical device specified above Is in conformity with the
European Regulation (EU) 2017/745 and Directive 2011/65/EU.

Copenhagen, February 19t 2024

Denys Lebedev, QA/RA Manager

1D: DN02476/02
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A.2 Manufacturer

g The models below are manufactured and sold by:
Auditdata A/S

Wildersgade 10B
1408, Copenhagen
Denmark

Phone: +45 70203124

www.auditdata.com

C€

Primus Fitting Unit - PFU+

2000 Primus Fitting Unit Pro
2000 Primus Audiometer Unit Ice
2000-1 Fitting Unit

2000 Primus HIT Pro

0123
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A.3 Labelling
Label samples

Measure

MeaSUF Auditdata

Hearin ent & Fitting Jare C £ 2 9
= ' e Software version 6.3.0

AUD & REM HIT

Connected Hardware 5/ Connected Hardware S/N
Firmware version Firmwar rsion

Firmware Checksum Firmware Checksum

Supported devices: Pimus Pro, Pnimus Ice, Pimus PFU+, 2000-1 Fitting Unit (Measure Aud), Primus HIT Pro

Auditdata A/S
C€ois Wildersgade 10B, 1408 Kabenhavn, Denmark

Copyright © 2011-2025 Auditdata A/S, Denmark m
‘FMOD Sound System’, copyright © Firelight Technologies Pty, Ltd., 1994-2009.
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Appendix B

B.1 Technical Specification

B.1.1 Fitting Unit

Item

Description

Value

Mechanical Data:

Primus Fitting Unit, without
cover

Primus Pro, without cover

Primus Ice, without cover

External measures Lx W x H
Weight

External measures L x W x H
Weight

External measures Lx W x H

345 x 110 x 35 mm
475 g

345x 112 x 35 mm
500 g

167 x 110 x 32 mm

Primus Pro, with cover

Primus Ice, with cover

External measures Lx W x H
Weight

External measures Lx W x H
Weight

Weight 375¢
Primus Fitting Unit, with External measures LXxW x H 350x 120 x 130 mm
cover Weight 800¢

360 x 120 x 96 mm
900 g

181 x115x94 mm
550¢g

2000-1 FU

External measures L x W x H

Weight

142 x 142 x 55 mm
415¢g

2000-1 FU (WL), wireless

External measures LXx W x H

Weight

142 x 142 x 55 mm
450 ¢g

Electrical Data:

% Power supply, low

power output

5 volts USB power

max 500 mA

@ Provided power sup-
plies for USB power in con-
junction with OPTO USB
cable (Type OPTICIS M2-
100-03)

type Friwo FW7662M/05

Input voltage 100-240V,
50/60 Hz, 150 mA; output
voltage 5Vdc, 1.1 A

type Friwo FW8002M/05

Input rated 100-240 V
+10%, 50/60 Hz, 160 mA.
Output rated 5 Vdc, 1.4 A

%3 Provided power sup-

plies for USB power in con-
junction with USB isolation

The USB Isolator has internal
power supply.

Output voltage 5 Vdc, 0.5 A
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Item

Description

Value

cable Type IF-TOOLS;

14000

ISOUSB-BOX-PLUS; Art. No.:

@ Provided power sup-
plies for high power output
functionality

Direct plug-in power supply, type
Friwo FW7362M/15

Input voltage 100-240 V AC,
50/60 Hz, 700 mA; output
voltage 15 Vdc, 2.0 A

Direct plug-in power supply, type
Friwo FW8030M/15

Input rated 100-240 V
+10%, 50/60 Hz, 300 mA.
Output rated 15 Vdc, 2.0 A

Free-field output

w/overload protection

2 channels, each up to 20
watts in 4 ohms *1#%4%5

3 channels, each up to 20
watts in 4 ohms *2%3

Left/Right, Sub/Mid, Rear | 500 mV RMS max load 16 ohms

Free Field Line Out*1*2

Line Out 1/Line Out 2/Line

Out 3 - Free Field Line

Out™3

Line Out/Demo Headset™#

Line Out™

Client*1%2/Demo*3 and L

Monitor Headset output 500 mV RMS max load 16 ohms

Operator microphone Electret microphone powered -40 dB+/-5 dB
inputs (0dB=1V/pa, 1000 Hz)

Talk back microphone Electret microphone powered -55 dB+/-4 dB

inputs

(0dB =1V/pa, 1000 Hz)

REM Probe input

Electret microphone powered
inputs

Refer to sec. B.2.2

Air and Bone Conductor
Outputs

For Tone and Speech:

3 Vrms (w. external power sup-
ply)

1 Vrms (USB only)

125 Hz - 16 kHz Frequency
Range For Bone Conductor:
250 Hz - 8kHz Frequency Range

Max load 4 ohm
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ltem Description Value
Calibration Refer to a separate manual for

calibration instructions.

Tone and Speech signals are cal-

ibrated for Max Hearing Level

Tolerance: +/- 3 dB (up to 8 kHz)

+/-5 dB (8 kHz and higher)

Masking signals are calibrated

for Max Sound Pressure Level
Client response button Normally open contact
Fuses Autofuses
Environmental Data:
Warm-up time (if stored at room temperature) 1 minute
Operating temperature With wireless applied parts 5°C-36°C
Operating temperature Without wireless applied parts 5°C-40°C
Storage temperature -30°C-70°C
Humidity 5% - 90%

Air pressure (altitude)

70 kPa (3000 meter) to
106 kPa (-400 meter)

Connectors:

@ DC power Pin 2.5 mm/Hole 7.0 mm
Pin: positive supply (+)
Ring: negative supply (-)

> USB 2.0 and USB 3.0 Complies with 60601-1 3" or USB-B*1%2%3%4

IEC 60950-1

USB-C*°

S/PDIF*3%5

Optical Audio

TOSLINK connector*3

Optical Mini Jack 3.5 mm*>®

Left speaker/Middle speak-
er/Right speaker

Anitek, H5-02-1-0-5-0

2 peg*4#S

3 pcs*1#2%3

Line Out 1/Line Out 2/Line
Out 3 - Free Field Line
out*3

Left/Right, Sub/Mid, Rear
Free Field Line Out*1*2

Stereo mini jack

3.5 mm
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ltem Description Value
Line Out/Demo Headset™4

Line Out™®

Operator and talk back Stereo mini jack 3.5mm
microphone input

Client*1*2/Demo*3 and | Stereo mini jack 3.5 mm
Monitor Headset output

Air conductor 1 *#1%2%3%4 | p|N 8 pin
Air conductor*® Mini-DIN 8 pin
Air conductor 2*1%2%3 DIN 8 pin
Air conductor HF* Mini-DIN 8 pin
Air conductor 3 (high fre- DIN 8 pin
quency)* 1x2%3

Bone conductor *1*2%3%4 | p|N 8 pin
Bone conductor*® Mini-DIN 8 pin
Client response*1*2#3%4 | p|N 8 pin
Client response*° Mini-DIN 8 pin
Option*2#*3 DIN 8 pin
Option*> Mini-DIN 8 pin
Probe*1/Real Ear DIN 8 pin
Probe*2#*3 input

REM Probe*® Mini-DIN 8 pin
Parts and Accessories*: Description

AUD (in Fitting Unit)

Clinical audiometer

REM (in Fitting Unit)

Real ear measurement unit

Speech Mapping

Speech Mapping with Live voice
and Percentile Analysis

A\ AUD/REM DC adaptor

15 volts/2A

& Optical USB connection

Type OPTICIS M2-100-03

Type IF-TOOLS; ISOUSB-BOX-
PLUS; Art. No.: 14000

Headset with microphone

Monitor headset w/boom micro-
phone for operator monitoring
and talk over

Headset without micro-

Monitor headset
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or talk back

ltem Description Value
phone
Microphone Table microphone for talk over

Extension cord for sound
attenuating booth

Loudspeaker incl. cable

Free-field loudspeaker for real
ear measurement and audi-
ometry

Insert Earphones

Audiometric insert earphones

Ear tips (small)

Insert ear tips for Primus Insert -
small (children)

Ear tips (medium)

Insert ear tips for Primus Insert -
medium

Ear tips (large)

Insert ear tips for Primus Insert -
large

Insert tube with nipples

For the Insert earphones only.
Length 200 mm

Probe tube guide

Probe tube stabilizer

*1 Only available in the PFU.
*2 Only available in the PFU+.

*3 Only available in Primus Pro.

*4 Only available in the Primus Ice.

*5 Only available in the 2000-1 Fitting Unit.

Applied Parts Type B

R ‘ Note: These parts must only be replaced by identical parts delivered by the manufacturer.

Item

Description

Insert Phone/Insert Earphone
Flex

Real Ear audiometric insert earphones (Model: Realear)

ER-3A Insert Headset

EarTone audiometric insert earphones (Model: EarTone

3A)

ER-3C Insert Headset

Etymotic audiometric insert earphones (Model: Etymotic

Research type 3C)

TDH-39 Headset

Supraaural audiometric headphone
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Item

Description

HDA-200 Headset

Sennheiser circumaural audiometric high frequency head-
phone

HDA-280 Headset

Sennheiser standard audiometric headphone

HDA-300 Headset

Sennheiser circumaural audiometric high frequency head-
phone

DD45 Headset

Interacoustics supraaural audiometric headphone

DD450 Headset

RadioEar circumaural audiometric high frequency head-
phone

DD65 Headset

Interacoustics circumaural audiometric headphone

DD65v2 Headset

RadioEar circumaural audiometric headphone

B-71 Bone Conductor

RadioEar audiometric bone conductor

Client response button

Single-button response switch

Free field calibration tool

Free field calibration microphone

Real Ear Probe/REM Probe Flex

REM Probe, binaural real-ear measurement probe set

Wireless REM Probe

Wireless REM Probe, binaural real-ear measurement
probe set

*) Note: The list of Parts and Acc

essories is subject to change without notice.

B.1.2 HIT - Hearing Instrument Test Unit

Item

Description

Value

Indoor use

Mechanical Data:

Hearing Instrument Test Unit

External measures Lx W x H 350 x 320 x 125 mm

Weight 4.5 kgs
Electrical Data:
Power supply, low power 5 volts USB power max 500 mA

(%3 Provided power supplies

for USB power in conjunction
with OPTO USB cable (Type

type Friwo FW7662M/05 Input voltage 100-240V,
50/60 Hz, 150 mA; output

voltage 5Vdc, 1.1 A

OPTICIS M2-100-03)

Input rated 100-240 +10%,
50-60Hz, 160 mA. Output
rated 5Vdc, 1.4 A.

type Friwo FW8002M/05

(%3 Provided power supplies

for USB power in conjunction
with USB isolation cable Type

The USB Isolator has internal
power supply.

Output voltage 5 Vdc, 0.5 A
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Item

Description

Value

IF-TOOLS; ISOUSB-BOX-PLUS;
Art. No.: 14000

A‘ Provided power supplies
for high power output func-
tionality

Direct plug-in power supply,
type Friwo FW7362M/15

Input voltage 100-240 V AC,
50/60 Hz, 700 mA; output
voltage 15 Vdc, 2.0 A

Direct plug-in power supply,
type Friwo FW8030M/15

Input rated 100-240 +10%,
50-60Hz, 300 mA. Output
rated 15Vdc, 2.0 A

MAINS supply voltage fluc-
tuations

up to +10 % of the nominal
voltage

TRANSIENT OVERVOLTAGES

up to the levels of
OVERVOLTAGE CATEGORY II;

NOTE 1 These levels of tran-
sient overvoltage are typical
for equipment supplied from
the building wiring.

TEMPORARY OVERVOLTAGES
occurring on the MAINS sup-

ply

2 500 V impulse withstand
voltage

Free-field output

w/overload protection

up to 20 watts in 4 ohms

Fuses

Autofuses

Environmental Data:

Warm-up time (if stored at room tem- 1 minute
perature)

Operating temperature 5°C-40°C

Storage temperature -30°C-70°C

Humidity 5% - 90%

Air pressure (altitude)

70 kPa (3000 meter) to
106 kPa (-400 meter)

Applicable POLLUTION

onment

DEGREE of the intended envir-

POLLUTION DEGREE 2 in
Mmost cases

Connectors:

DC power

Pin 2.5mm/hole 7.0mm
Pin: positive supply (+)

Ring: negative supply (-)
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ltem Description Value

USB 2.0 and USB 3.0 Complies with 60601-1 3" or | USB-B
IEC 60950-1

Left HI-PRO or NOAHIink™ 6 pin mini DIN

input

Right HI-PRO or NOAHIink™ | 6 pin mini DIN

input

Monitor headset Stereo mini jack 3.5mm

Parts and Accessories*:

Description

Reference microphone

Installed, Electret goose neck
type

Coupler microphone

Installed, Electret type

Coupler

2 cc coupler with attach-
ments for ITE, BTE, and Body-
worn Hearing Instruments

Battery pills, 5 sizes

Type 5A, 10A, 312, 13 and
675

BTE tube PVC tube for BTE Hearing
Instruments. Length 25 mm
ITE putty Putty for fastening of ITE Hear-

ing Instruments to the ITE
coupler

*) Note: The list of Parts and Accessories is subject to change without notice.
An updated list will always be available from our homepage: www.auditdata.com.

B.2 Technical Data
B.2.1 AUD system

No. of channels:

Full 2 channel

Tone presentation:

Steady, pulsed

Signal types:

Pure Tone:

IEC 60645-3:2007

125 Hz- 16 kHz*

Accuracy within 0.2%
Modulated Tone:

125 Hz - 8 kHz

Triangular linear

10.8 Hz Repetition Rate
+/-10% Frequency Deviation
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(of carrier frequency)

Masking types:

Narrow Band Noise:

IEC 60645-1, 1/3 Octave fil-
ter with geometric center fre-
quency as the audiometric
TONE frequency

White Noise:

100-20000 Hz with +3
dB/octave throughout its fre-
guency range

Speech-weighted:

IEC 60645,

125-1000 Hz +3 dB/octave ,
1000-6000 Hz - 9 dB/octave

Pink Noise:

100-20000 Hz, +/-1 dB
throughout its frequency
range

Hearing levels:

-10 dB-120 dB HL

Deviation, dB:

0.5dB

Distortion:

Less than 3 % for air con-
duction.

Less than 6% for bone con-
duction.

* Primus Ice supports 125 Hz - 8 kHz only.

B.2.2 REM system

No. of channels:

4 channel (2 probe micro-
phone units with each a ref-
erence mic. and a probe mic.)

Signal types: White noise, speech-weighted
noise, and pink noise.
For technical specifications
refer to section B.2.1.

Further Signals: ISTS Signal according to IEC

60118-15,
Crest factor: 17
ISTS MPO signal
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Peak-Level: 90dB

SPL Frequencies: 0,5, 1, 2, 3,
4 KHz

Ontime: 250 ms

Off time: 250 ms

Rise- and fall time: 25 ms
ICRA Signals: (Hearing Aid
Clinical

Test Environment Stand-
ardization)

DSL Signals: Female “S” and
“gH”

(Child Amplification Lab-
oratory

National Centre for Audiology
Western University London,
Ontario)

Frequency range:

125 Hz - 16 kHz

Signal levels:

50 - 90 dB SPL

Accuracy:

Within 4 dB

Signal Analysis:

Analysis type: FFT

Analysis bandwidth:

125 Hz to 16 kHz

Resolution: 24 bands/Octave
Windowing type: Hann

Equalization type:

Modified pressure method

Sensitivity, Probe Mic.

Depending on selected input
range,

10 ranges available

-35dB (0 dB =1V/pa, 1000
Hz)

Sensitivity, Reference Mic.

Depending on selected input
range,

6 ranges available

-35dB (0 dB=1V/pa, 1000
Hz)

Measurement Range

40 dB SPL to 100 dB SPL

B.2.3 HIT system

No. of channels:

2 channel - One coupler micro-
phone and one reference
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microphone

Signal types:

Pure tone, modulated tone,
narrowband noise, white
noise, speech-weighted
noise, and pink noise.

For technical specifications
refer to section B.2.1.

Frequency range:

200 Hz - 16 kHz

Signal levels:

40 - 100 dB SPL

Tolerance, dB:

+/- 1,5 dB in the frequency
range 200 - 2000 Hz and +/-
2,5 dB in the frequency range
2000 - 5000 Hz and above.

Pure tone accuracy:

+/-2%

Distortion:

Less than 0,5% at 70 dB.
Less than 2% at 90 dB.

B.2.4 Insert Phone/Insert Earphone Flex

Insert Phone/lInsert
Earphone Flex

Including Audiometric insert
earphones

Frequency range:

125 Hz to 8 kHz

Maximum output level:

Up to 120 dB HL at mid fre-
quencies

Compliance:

EN 60645 and ISO 389-2

B.2.5 Real Ear Probe/REM Probe Flex

Real Ear Probe/REM Probe
Flex

Adjustable left and right-ear
hangers, each with reference
and probe tube microphone

Frequency range:

125 Hz to 16 kHz

Maximum input level for
probe tube input:

125 dB SPL with less than
3% distortion.
Up to 135 dB SPL

Wireless REM Probe

Parameter

Value

Frequency Range

125Hz to 16KHz
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Maximum SPL 106dB ref, 126dB probe
Sensitivity -35dB

Equivalent Noise Level SNR > 62dB

Physical Weight 45¢g

Dimensions (L x B x H) 197 x 170 x 18 mm
Battery capacity 250mAh 3.7V

Operating Temperature 5°C-36°C

Battery life (on one charge):

Up to 5 hours measurement

Operating range (Line of
sight)

Recommended maximum
range 5.5 meters from FU
with no obstruction

Standards device is com-
pliant with

ANSI S3.46, IEC 61669, EN
61669

B.3 EMC Conformance Requirements

B.3.1 EMC Classification, Standards and Test Methods

Emissions:

EN 55011/CISPR11, Group 1, Class B

Harmonic Current Emission:

IEC 61000-3-2:2018, Class A

Voltage Fluctuations and Flicker:

IEC 61000-3-3:2013

Immunity:

Test levels for professional healthcare environment.

Enclosure Port:

Basic EMC standard

Immunity test level

IEC 61000-4-2 (ESD)

+ 8 kV contact, + 2 kV, £ 4 kV, £ 8 kV, £ 15 KV air

IEC 61000-4-3 (rad. Fields)

3V/m, 80 MHz - 2,7 GHz, 80 % AM at 1 kHz

equipment):

385 MHz; Pulse Modulation: 18 Hz; 27 V/m

V/m

V/m

& Test points / frequencies according to table 9 of
IEC/EN 60601-1-2 (RF wireless communications

450 MHz, FM + 5Hz deviation: 1 kHz sine; 28 V/m
710, 745, 780 MHz; Pulse Modulation: 217 Hz; 9

810, 870, 930 MHz; Pulse Modulation: 18 Hz; 28

1720, 1845, 1970 MHz; Pulse Mod.: 217 Hz; 28 V/m
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2450 MHz; Pulse Modulation: 217 Hz; 28 V/m;

5240, 5500, 5785 MHz; Pulse Mod.: 217 Hz; 9 V/m

IEC 61000-4-8 (magn. Fields)

30A/m, 50 Hz & 60 Hz

Input a.c. Power Port:

Basic EMC standard

Immunity test level

IEC 61000-4-4 (bursts)

+ 2 kV, 100 kHz repetition frequency

IEC 61000-4-5 (surges)

+ 0,5kV, £ 1 kV, line to line

IEC 61000-4-6 (cond. RF)

3V/m, 0,15 MHz - 80 MHz, 80 % AM at 1 kHz

6 V/m in ISM bands between 0,15 MHz and 80 MHz

IEC 61000-4-11 (volt. dips)

0 % UT,; 0,5 cycleat 0°,45°,90°, 135°, 180°,
225°,270°

at0°

and 315°.0 % UT; 1 cycle and 70 % UT; 25/30 cycles

IEC 61000-4-11 (volt. inter.)

0 % UT; 250/300 cycle

Patient Coupling Port: Device has no patient coupling port

Signal Input / Output Port:

Basic EMC standard

Immunity test level

IEC 61000-4-2 (ESD) + 8 kV contact, + 2 kV, + 4 kV, £ 8 kV, + 15 kV air

IEC 61000-4-4 (bursts) Only applicable for patient headsets, patient client
switch and speaker cables because cable length
might be > 3m.

IEC 61000-4-5 (surges) N/A; all SIP/SOP cables not directly connected to out-

door cables.

IEC 61000-4-6 (cond. RF)

switch and speaker cables because cable length
might be > 3m.

Only applicable for patient headsets, patient client

B.3.2 Maximum permissible Cable Lengths of Accessories

Accessory, Transducer

Maximum cable length

Client response switch

Air conductor headsets like
TDH39, DD45, DD450,

Power Supply (low voltage 1,8 meters

side)

USB cable 3 meters

REM probes 2,5 meters (In combination

with extension cable
91.0704 prolongable up to
5,5 meters)
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HDA300

Bone conductor headsets
like B71

Insert headsets like EAR-3A,
ER-3C

2 meters (In combination with
extension cable 91.0704 pro-
longable up to 5,5 meters)

Free field calibration micro- 3 meters
phone

Table microphone (Talk back | 2,5 meters
microphone)

Headset with microphone 2,5 meters
(Monitor headset)

Loudspeaker LSO1 5 meters
RECD Speaker LS Mini 2,5 meters
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B.4 Pin Assignments Table

Primus Fitting Unit

Connector

Air Conductor 1, 2, 3 |BOne Conductor

Standard DIN Connector 8 pins

female

1. Ground 1. Output

2. Data Up/Down- 2. Data

load Up/Download

3. Ground 3. Not Con-
nected

4. Optional Micro- 4. Not Con-

phone Input nected

5. Plug Detect 5. Plug Detect

6. Left Channel Out-

6. Ground
put
7. Right Channel Out- | 7. Not Con-
put nected
8. Ground 8. Ground

Option™2*3

Primus Probe*1/Real Ear
Probe *2*3

Client Response

1. Secondary Micro-
phone Input

1. Ground

1. Not Connected

2. Data Up/Download

2. Data Up/Download

2. Logic Input (High/Low)

3. Ground

3. Ground

3. Not Connected

4. Primary Microphone
Input

4. Reference Microphone
Input, Left

4. +3.3Vdc

5. Plug Detect

5. Reference Microphone
Input, Right

5. Plug Detect

6. Speaker Output,
positive

6. Probe Microphone Input,
Left

6. Control Clock

7. Speaker Output,
negative

7. Probe Microphone Input,
Right

7. Control Data

8. Ground

8. Ground

8. Ground
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Connector

Client*1"2/Demo ™3
Headset

Free Field: Left/Right, Rear
and Sub/Mid*1*2

Free Field: Line out 1, Line out
2 Line out 3*3

3.5 mm TRS socket (mini-jack)

1. Left Channel
Output

1. Channel 1,3,5 Output

2. Right Channel
Output

2. Channel 2,4,6 Output

3. Ground 3. Ground

. Operator Micro- Operator Micro- .
Monitor Headset phone Left phone Right Talk Back Microphone
1. Left Channel
Output 1. Input 1. Input 1. Input
2. Right Channel 2. Not Connected | 2. Not Connected | 2. Not Connected
Output
3. Ground 3. Ground 3. Ground 3. Ground

Power supply: DC POWER JACK

1.+15 Vdc, 2A max
(Center)

2. Ground (Sleeve)
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USB: Type B connector
1. 5 Vdc, 0.5A max
2. Data -
1 2
— —
- _— 3. Data +
4 3
4. Ground
| — SPDIF: Toslink optical

transmitter™3
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Speaker Output Right, Mid, Left
1. Positive
2. Negative
1 2
*1 This plug is only available in the PFU.
*2 This plug is only available in the PFU+.
*3 This plug is only available in the Primus Pro.
2000-1 Fitting Unit
8-pin Mini-Din Connector
. Connector
Front View .
Pin AC1 Client REM
, ien .
AC2 BC Resp. | OPU" | probe
. |Pue Plug Plug Plug fele%‘n?vllic
detect detect detect detect R ) '
Signal Signal
2 Ground | Ground |+3.3VDC | Coupler Ref. Mic.
Mic. L
RECD Signal
3 Signal R | Signal I2C Data | Speaker | Tube
+ Mic. R
4 Data Data Pat. Signal Data Data
RECD Signal
5 Signal L | Signal I2S Clock | Speaker - | Tube
Mic. L
6 Ground | Sig. Ground Ground Ground
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. Tube
R Ground Ref. Mic. Mic. R
Ground Ground
7 Ground | Ground | Ground Coupl. Ref. Mic.
Mic. L&R
. ) Ground
3 Ground | Sig. Ground Slgnall Tube
L Ground Ref. Mic. .
Mic. L
3.5 mm Stereo Jack Connector
Talk Back
o Monitor Microphone,
in Operator
Headset, .
Line Out Microphone,
Ambient
Microphone
. Signal Input
, Signal Out-| -
1 (Tip) out Left (Bias Voltage)
. Signal Out-| Not con-
2 (Ring) put Right [ nected
3
(Sleeve) Ground Ground
Power Supply, DC Power Jack Pin Signal
m | Center Pin +15VDC / max. 2A
Sleeve Ground
Speaker, Left and Right Pin Signal

© Auditdata - 2025, ID: 20.0109/24 B-19



Instructions for use

Positive Terminal

Negative Terminal
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Appendix C

C.1 Minimum Requirements (for Software Installation)

C.1.1 PC specifications for the connected operator PC

Minimum requirements

Recommended requirements

Processor/clock speed

2 GHz

2 GHz (or higher) multi-core

System RAM

2GB

4 GB or more

Free hard drive space

2GB

2GB

Operating System*

Windows 10 and Windows 10
Anniversary Update

Windows 10 and Windows 10
Anniversary Update

Windows 11
Screen Resolution 1280 x 1024 1600 x 1200
Graphics Card XVGA Dual monitor output

CD Drive

Required if speech test CD "s
are used.

Required if speech test CD "s
are used.

Connection of Fitting Sys-
tem to PC

USB connector 2.0 or higher

USB connector 2.0 or higher

Connection of HIT System
to PC (optional)

USB connector 2.0** or higher

USB connector 2.0** or higher

* Your OS must be up to date. All Windows updates must be installed.

** |f a USB hub must be used in order to connect both units, a hub with power supply is recom-

mended.
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